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About the Manuals
Included with the Reader is the Quick Start Guide and this 
PDF-format User’s Guide. Additionally, after installing eBook 
Library software from the supplied CD-ROM, you can refer 
to the Help within eBook Library.

Browsing the User’s Guide

This PDF-format User’s Guide can be browsed on both your 
computer and the Reader.

Browsing this Guide on your computer
Click the Start menu in the bottom left of the Desktop, then 
select “All Programs” – “Reader” – “PRS-505 User’s Guide” 
to start Adobe Reader and open the User’s Guide.
For details on how to use Adobe Reader, refer to Adobe 
Reader Help.

Hint
• To view the User’s Guide, you should have installed Adobe Reader 

5.0 or later. Adobe Reader can be downloaded for free from the 
Adobe website (www.adobe.com).
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Browsing this Guide using the Reader
From the Home menu, select “Books by Title” – “User’s 
Guide” from the Book list. The User’s Guide can be opened 
by selecting “Option Menu” – “Begin.”
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 (size) button

Hints
• A  mark on this Guide indicates a link. Using the ////Enter 

buttons, press / to select the desired link, then press Enter to 
jump to the linked page.

• To zoom in a page, press  (size).

For details on how to open books or PDF files, refer to  page 
35, 39.

Using the eBook Library Help

Refer to the eBook Library Help for details about using 
eBook Library, such as importing books to your computer 
and transferring them to the Reader.
Follow the steps below to start eBook Library and browse 
Help.

 Click the Start menu from your computer, then 
select “All Programs” – “Reader” – “eBook Library.”

 Click “Help” – “eBook Library Help” on the Menu bar.
Help appears.
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Introduction

What You Can Do with Reader
First, read the Quick Start Guide to prepare the Reader for 
use. Initially after purchase, you need to charge the Reader 
battery and install the dedicated software “eBook Library” on 
your computer.
Once initial preparation is complete, you can transfer 
content from your computer to the Reader to take anywhere 
you wish.

Downloaded 
eBooks*1

*2

*1	 CONNECT	eBooks	(online	e-Book	store)
*2	 Book/Audio/Picture	files	that	you	already	have

Transferring

Charge the Reader, then install eBook Library 
on your computer.

Download eBooks from  
CONNECT eBooks on your 
computer.

Transfer content from your 
computer to the Reader 
using eBook Library.

Enjoy content on the 
Reader.

Reading/
Playing/Viewing

Importing

Getting Started
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Guide to Parts and Controls

Front
 Enter button*1

To decide an item or apply a setting, 
press the Enter button.

 /// buttons*1

To select an item or scroll around the screen, press  
(left),  (up),  (down), or  (right).

*1	 In	this	manual,	the	operation	of	the	////Enter	buttons	are	
explained	as	follows.

	 (Example)	Press	///	to	select	“Away”	on	the	Book	list,	then	
press	Enter.

Continued

Enter button
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 MENU button
To return to the previous screen or show a menu. (  
page 13)

  (page) / (>/<) buttons
To turn the page or proceed/return to the next (>)/
previous (<) content. (  page 36, 38, 53, 56)

 Number (1 – 9,0) buttons
To select the numbered items on the screen or input 
numeric values on the Setting menu. (  page 36, 38, 51, 
55)

 SD Memory Card slot
To insert a SD Memory Card (optional). (  page 20)

 “Memory Stick Duo” slot
To insert a “Memory Stick Duo” (optional). (  page 20)

 POWER switch
To switch on/off the Reader. (  page 15)

 Indicator
Lights up in red while charging, and goes off when 
charging is complete. (  page 17)
Flashes in orange while the Reader is accessing your 
computer via USB.
Also flashes in orange while switching the Reader on or 
off.
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 Holes for soft cover attachment
The soft cover is attached when purchased. (  page 12)
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Folds open in use

Note
• Do not leave the Reader in a high temperature conditions, as it 

may damage the soft cover.

  (size) button
To zoom in/out a page or picture. (  page 39, 56)

  (MARK) button
To create/remove a bookmark. (  page 47)

 Hole for hand strap
To attach the hand strap.

 USB connector
To connect the USB cable (supplied). (  page 28)

 DC IN jack
To connect the AC power adapter (optional).

 Hint
• The Reader can be charged by connecting to a computer 

using the supplied USB cable.
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  (Headphones) jack
To connect headphones (optional). (  page 51)

 VOLUME +/– buttons
To adjust the volume. (  page 53)
To mute the sound, press and hold the VOLUME +/– 
buttons. To restore the sound, press the VOLUME +/– 
buttons again.

Rear

 Reset button
To reset the Reader if no operation is possible. (  page 
68)
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About the serial number
The serial number provided for the Reader is required for 
the customer registration. The number is on the label on the 
rear of the Reader. Do not remove the label.

Removing/attaching the soft cover
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Removing the soft cover
 Pull the tab of soft cover towards A.
 Remove the Reader in the direction of B.

Attaching the soft cover
 Insert the tab C of the soft cover in the hole D of the 

Reader.
 Pull the tab of the soft cover towards A.
 Insert the Reader in the direction of E to attach it to the 

soft cover.
 Check that the tabs of the soft cover are completely 

inserted in the holes of the Reader.

Note

• Note that the tab of the soft cover may become deformed, if you 
pull the tab too strongly.
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Basic Operations

Menu Operations
You can switch between screens, read/play/view content, or 
set items, using the ////Enter buttons, number buttons, 
or MENU.
Example: screen transition diagram of the Home menu – 
Book list – Option menu – Book page

Press / to 
select, then 
press Enter.

Press MENU to 
return to the 
previous screen.

Number tab
Selected item is highlighted in black.

Press / to select “Books by Title” then press 
Enter.

Press / to select, 
then press Enter.

If the stored books are more than 30, 
the Index menu appears. (  page 43, 
45)

Continued 13 US



PRS-505.GB.3-277-508-01(2)

Hints
• By pressing and holding  (size), screen orientation can be 

switched (vertically/horizontally). (  page 41)
• By using the number buttons, corresponding numbered items can 

be selected.
• By pressing and holding MENU, the screen can be returned to the 

Home menu.
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Turning on Reader
Slide the POWER switch in the direction of  to turn on the 
Reader.

Slide the POWER 
switch.

The Reader turns on.
It may take a few moments to turn on the Reader and the 
start-up screen to appear when used for the first time, after 
a reset or shut down, or when the battery has depleted.
The indicator lights up in orange when the Reader is turned 
on.

To turn off the Reader
Slide the POWER switch in the direction of  again.
The Reader turns off.
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About the Sleep Mode (resume function)
You can set the Reader to automatically enter sleep mode. 
In sleep mode, the Reader automatically turns off if no 
operation is performed for 60 minutes (resume function). 
The previously displayed screen appears when turned on by 
sliding the POWER switch from this state.
The Sleep Mode setting can be configured from the Setting 
menu (  page 61).

Note

• In the following states, the Reader will not automatically turn off, 
even if no operation is performed for 60 minutes.
– When connected to the computer using the supplied USB cable
– When connected to the AC Adaptor for Reader (AC-S5220E) 

(optional) to charge
– When playing audio files
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About charging
Charging the Reader is required when using for the first 
time. Turn on the Reader, and then charge in one of the 
following two ways.
• Connect to a computer via USB (Refer to the Quick Start Guide 

and  page 27). 
(Charging time: approx. 4 hours*)

• Connect to an AC outlet using the AC power adapter and AC 
power cord (optional). 
(Charging time: approx. 2 hours*)
* Approximate time required to fully charge the battery.

Notes

• When you connect the Reader to your computer,  (indicating 
connection via USB) is displayed on the Reader’s screen. If the 
battery has been fully depleted, it takes about 40 minutes until  
is displayed, and you will not be able to turn on the Reader by the 
POWER switch during this time. In this case, wait until  is 
displayed. The indicator lights up in red while  is not displayed, 
and the Reader is charged.

• If the remaining battery power of a connected notebook computer 
is low, charging via USB connection may not be possible.

• If you connect the Reader to a notebook computer which is not 
connected to an AC outlet, the battery of the notebook computer 
will be consumed. Do not leave the Reader connected to a 
notebook computer which is not connected to an AC outlet for an 
extended period.

• Connecting the Reader via a USB hub or extension cable may not 
work and is not supported. Connect the USB cable directly to the 
computer.
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You can verify the remaining battery power by checking the 
indicator in the bottom left of the screen. Charge the battery 
when remaining power is low (the fewer black segments 
indicated, the lower the remaining power).

Note

• If the remaining battery power is low, the following warning 
appears. Charge the battery.

 

 If you continue to use without charging, the following warning 
appears, and the Reader will turn off automatically.

 Charge the Reader and turn it on again.
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Inserting a Memory Card
The following memory cards can be inserted in the Media 
slots of the Reader.

Note

• The Reader has separate slots for “Memory Stick Duo” and the SD 
Memory Card. Be sure to insert the memory card in the correct 
slot. Inserting the memory card in the wrong slot may damage the 
slot and the memory card.

“Memory Stick Duo”*1 “Memory Stick Duo” 
“Memory Stick PRO Duo”

SD Memory Card*2 SD Memory Card
miniSD Card *3

*1 The Reader does not comply with MagicGate standard, and the data 
requiring the copyright protection function cannot be copied or played 
on the Reader.

*2 The Reader does not comply with copyright protection of SD Memory 
Cards.

*3 miniSD Card adaptor (sold separately) required.

Notes

• An operation check is performed when using a “Memory Stick Duo” 
of up to 8 GB, however, operation of all “Memory Stick Duo” is not 
guaranteed.

• An operation check is performed when using an SD Memory Card 
of up to 2 GB, however, operation of all SD Memory Cards is not 
guaranteed.

• When inserting the memory card into the Reader, it may take time 
for the Reader to recognize the content files in the memory card if 
the capacity of the content files stored on the memory card is large.
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Inserting a memory card into the Reader

 Remove dummy cards from the “Memory Stick Duo” 
slot and SD Memory Card slot.
The dummy cards are inserted in the “Memory Stick 
Duo” slot and the SD Memory Card slot at purchase. 
When not using the memory card, insert the dummy 
card into the slot.

Note

• If the dummy card is not inserted in the slot, foreign objects may 
enter the slot, and cause malfunction or damage.
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 Insert a memory card in the  direction with its label 
side up until it clicks into the place.

Note

• The Reader has separate slots for “Memory Stick Duo” and the 
SD Memory Card. Be sure to insert the memory card in the 
correct slot. Inserting the memory card in the wrong slot may 
damage the slot and the memory card.

  
Mark

“Memory 
Stick Duo”

SD Memory 
Card

  
Mark

Notes

• Be sure to insert the memory card in the correct direction. Forced 
insertion may damage the slot.

• Do not insert an incompatible memory card, as it may cause 
malfunction.

• Do not use a deformed memory card or adaptor.

21 US



PRS-505.GB.3-277-508-01(2)

Removing a memory card from the Reader

 Gently push in the memory card.
You will hear a click, and the memory card pops out.

“Memory 
Stick Duo”

SD Memory 
Card

 Remove the memory card squarely from the 
“Memory Stick Duo” slot or the SD Memory Card 
slot.

Notes

• Do not remove a memory card or turn off the Reader while reading 
or writing data, as data may be damaged.

• For details on handling memory cards, refer to  page 86.
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Importing Content

Importing eBooks from CONNECT 
eBooks
You can download eBooks from the online e-Book store 
“CONNECT eBooks” to your computer.
Use the dedicated software eBook Library to access 
CONNECT eBooks.

Notes

• To download eBooks, you need to prepare an Internet-accessible 
environment on your computer.

• You need to authorize your computer to CONNECT eBooks to 
download eBooks.

 You also need to authorize the Reader to CONNECT eBooks to 
transfer and read downloaded eBooks on the Reader.

 For details, refer to the eBook Library Help.

 Double-click the eBook Library icon ( ) on 
Windows desktop.

	 Hint
• You can also start eBook Library by clicking the Start menu and 

then selecting “All Programs” – “Reader” – “eBook Library.”

 Click “eBook Store” in the Source view.
The View area is switched to the Store view and 
CONNECT eBooks appears.
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 Follow the page instructions to purchase 
(download).
Downloaded eBooks are automatically imported to
“Library” in the Source view.

Library Downloaded 
content

Source view

	 Hint
• Purchased eBooks are grouped under “Purchased” in the 

collection.

Hints
• eBooks can be read on eBook Library using your computer. For 

details on eBook Library operations, refer to the eBook Library 
Help.

• The Source view appearance may vary depending on your 
computer.
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Importing Content from Your 
Computer
You can import content files stored on your computer into 
Library of eBook Library.

You can import the following content files.
• Book 

PDF file, Text file, RTF file, Word file*, BBeB Book
• Audio 

Un-encrypted MP3 and AAC format audio files
– MP3 file (.mp3 file extension) 

The following specifications should be met in order to import an 
MP3 file. 
Bit rate: 32 to 320 kbps 
Sampling frequency: 22.05, 44.1 kHz

– AAC file ( .mp4, .m4a, .mov, or .qt file extension) 
The following specifications should be met in order to import an 
AAC file. 
Bit rate: 40 to 320 kbps 
Sampling frequency: 24.0, 44.1, 48.0 kHz

• Picture 
Bitmap file, JPEG file, GIF file, PNG file

 * Word files will be automatically converted into RTF files during 
transfer only if Microsoft Word is installed on your computer.

For details on content files you can import, refer to the 
eBook Library Help.
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Importing content files

You can select content files stored on your computer and 
import them into Library.

 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

 Click “Import Files” on the “File” menu.
The “Import Files” dialog box appears.

 Click  of the “Look in” list to select the folder 
containing the content file(s) to be imported, as 
necessary.
The content files in the selected folder are listed.

	 Hint
• You can also double-click the folder (in the folder list) to display 

the content files in the folder.

 Select the content file to be imported.
To select multiple files, click the files while holding down 
the Ctrl key.

 Click “Open.”
The content file(s) is imported into Library.

Hint
• You can import all the content files in a selected folder at the same 

time into Library from “Import Folder” on the “File” menu.
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Transferring Content

Transferring Content to Reader 
Connected with Your Computer
You can transfer (copy) the content in the Library to the 
Reader.

Note

• If the Reader is locked, it will not be recognized on your computer 
and content cannot be transferred. (  page 63) If you connect the 
Reader to your computer, disconnect it and unlock the Reader by 
inputting the password.

Hints
• The book content can be grouped in the Library as a collection, 

which can be transferred to the Reader. For details on how to 
create or transfer a collection, refer to the eBook Library Help.

• You can synchronize content in Library of eBook Library with the 
Reader by specifying a folder (such as “Library” or the sub-items 
under “Library”). (  page 34) The Reader can be automatically 
updated to match the content in Library, when you connect it to 
your computer.

 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.
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 Connect the Reader to your computer using the 
supplied USB cable.

USB cable  
(supplied)

To USB connector

“Sony’s Reader” appears in the Source view of eBook 
Library.
A screen appears on the Reader, indicating that it is 
connected to the computer.
Notes

• If “Sony’s Reader” does not appear in the source view after 
connecting the Reader to your computer, disconnect the USB 
cable from the Reader, then reconnect it after a while.

• When you connect the Reader to your computer,  
(indicating connection via USB) is displayed on the Reader’s 
screen. If the battery has been fully depleted, it takes about 40 
minutes until  is displayed, and you will not be able to turn 
on the Reader by the POWER switch during this time. In this 
case, wait until  is displayed. The indicator lights up in red 
while  is not displayed, and the Reader is charged.
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 Click “Library” in the Source view, then click  (List 
view).
The View area is switched to the List view and all the 
content in the Library is listed.

 Hints
• When you click “Books,” “Audio” or “Pictures” in the Source view, 

only their respective content is displayed.
• When you click  (Thumbnail view), content can be displayed as 

thumbnails.
• You can create a collection in the Library and the collection can 

be transferred to the Reader. For details on how to create or 
transfer a collection, refer to the eBook Library Help.

 Select the content you want to transfer from the list.
To select multiple content, click the content while 
holding down the Ctrl key.

 Drag the content from the list to “Sony’s Reader” in 
the Source view.
The content is transferred to the Reader.

Sony’s Reader
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Hint
• You can store computer data into the built-in flash memory of the 

Reader by transferring the data from your computer using Windows 
Explorer.

Notes

• If there is not enough free space on the memory of the Reader, 
content may not be transferable. Transfer any unnecessary content 
back to eBook Library, then delete it to increase free space on the 
Reader. (  page 32)

• Do not delete files in the folder under “database,” and files in 
“database,” using Windows Explorer. Perform data management 
using eBook Library. For details on the eBook Library operations, 
refer to the eBook Library Help.

Transferring content via a memory card

Content imported to eBook Library can be transferred to a 
memory card on the Reader.

Hint
• “Memory Stick Duo” and SD Memory Card can be used.

 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

 Connect the Reader to your computer using the 
supplied USB cable. (  page 28)
“Sony’s Reader” appears in the Source view of eBook 
Library.
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 Insert a memory card into the Media slot of the 
Reader. (  page 20)
“Memory Stick/SD Card on Sony’s Reader” appears in 
the Source view.

 Click “Library” in the Source view of eBook Library, 
then click  (List view).
The View area is switched to the List view and all the 
content in Library is listed.

	 Hints
• When you click “Books,” “Audio” or “Pictures” in the Source view, 

only their respective content is displayed.
• When you click  (Thumbnail view), contents can be displayed as 

thumbnails.
• You can create a collection in Library and the collection can be 

transferred to a memory card on the Reader. For details on how to 
create or transfer a collection, refer to the eBook Library Help.

 Select the content you want to transfer from the list.
To select multiple content, click the content while 
holding down the Ctrl key.

 Drag the content from the list to “Memory Stick/SD 
Card on Sony’s Reader” in the Source view.
The content is transferred to the memory card on the 
Reader.
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Hint
• You can store computer data into the memory card on the Reader 

by transferring the data from your computer using Windows 
Explorer.

Notes

• If there is not enough free space on the memory card, content may 
not be transferable. Transfer any unnecessary content back to 
eBook Library, then delete it to increase free space on the memory 
card. (  page 32)

• Do not delete files in the folder under “Sony Reader,” and files in 
“Sony Reader,” using Windows Explorer. Perform data 
management on eBook Library. For details on eBook Library 
operations, refer to the eBook Library Help.

To transfer content back to eBook Library

 Click the Start menu, then select “All Programs” - 
“Reader” - “eBook Library” to start eBook Library.

 Connect the Reader to your computer using the 
supplied USB cable. (  page 28)
“Sony’s Reader” appears in the Source view.
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 Click “Sony’s Reader” in the Source view, then click 
 (List view).

The View area is switched to the List view and all the 
content in Library is listed.

 Hints
• When you click “Books,” “Audio” or “Pictures” in the Source view, 

only their respective content is displayed.
• When you click  (Thumbnail view), contents can be displayed as 

thumbnails.
• You can create a collection in the Reader and a memory card on 

the Reader, and the collection can be transferred to eBook 
Library. For details on how to create or transfer a collection, refer 
to the eBook Library Help.

 Select the content you want to transfer back from 
the list.
To select multiple content, click the content while 
holding down the Ctrl key.

 Drag the content from the list to “Library” in the 
Source view.
The content is transferred back to eBook Library.
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Synchronizing content in Library with Reader

You can synchronize content in the Library of eBook Library 
with the Reader by specifying a folder (such as “Library” or 
the sub-items under “Library”). The Reader can be 
automatically updated to match the content in the Library, 
when you connect it to your computer.

Note

• To synchronize content in the Library of eBook Library with the 
Reader, you need to specify a folder (such as “Library” or the sub-
items under “Library”). For details on how to specify a folder, refer 
to the eBook Library Help.

Hint
• When you want to synchronize content in the Library with the 

Reader right away, you can also synchronize them manually. For 
details on how to synchronize content manually, refer to the eBook 
Library Help.

 Click the Start menu, then select “All Programs” – 
“Reader” – “eBook Library” to start eBook Library.

 Connect the Reader to your computer using the 
supplied USB cable. (  page 28)
eBook Library starts synchronizing content in the 
Library with the Reader automatically.

Hint
• If you start eBook Library after connecting the Reader to your 

computer, eBook Library also starts synchronizing content in 
Library with the Reader automatically.
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Reading/Playing/Viewing Content

Reading Books
Reading books transferred from your computer

Follow the steps below to read books transferred from your 
computer.

 In the Home menu, press / to select “Books by 
Title,” then press Enter.
The Book list appears.
If the contents of the book on the Reader and the 
memory card exceed 30 items, the Index menu appears. 
The Book list can be further sorted by selecting the 
category item in the Index menu. (  page 43) 

Indicates that 
content is 
stored on a 
memory card.

: “Memory 
Stick Duo”

: SD Memory 
Card

Number tabs

 indicator
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	 Hints
• The content on the memory card also appears in the Book list.
• In addition to /, you can also select an item by pressing the 

same number button as indicated on the number tab.
• To display the rest of the list, press > (repeatedly).
• You can jump directly to the last displayed page by selecting 

“Continue Reading” from the Home menu, without displaying the 
Book list. 

• If an invalid operation is performed,  appears at the bottom of 
the screen.

 Press / to select the desired book from the list, 
then press Enter.
The Option menu appears. (  page 37)

 Press / to select how to open the book, then 
press Enter.
To read the book from the beginning, press / to 
select “Begin,” then press Enter.
The first page of the book appears.

To open the book’s table of contents or the bookmarks 
of the PDF file, press / to select “Table of Contents,” 
then press Enter.
The table of contents/bookmarks appears (if contained 
in the book/PDF file).

Press MENU to close the book.
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About the Option menu
The book title is displayed.

To open the last displayed page.
To open the first page of the book.
To open the final page of the book.
To open the Bookmark list. (  page 47)
To open the table of contents of the 
book or the bookmarks of the PDF file, 
if contained in the book/PDF file. 
To open the list of previously displayed 
pages (  page 50)

To remove all bookmarks or clear history.  
(  page 49, 50)

To display the book information. (  page 42)

Book types supported by the Reader
The following are the book types supported by the Reader 
and their characteristics.

eBook
(.lrf and .lrx file 
extension)

A book in BBeB format that you can 
download from CONNECT eBooks.
The link tool embedded in eBooks (page 
jumps, etc.) can be used. (  page 39)

PDF file
(.pdf file 
extension)

A File in PDF format (Version 1.4 or before)
Bookmark and link tool on PDF files can 
be used.

Text file
(.txt file extension)
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RTF file 
(rtf. file extension)

An RTF file that is automatically converted 
from a Microsoft Word file.*
* Only if Microsoft Word is installed on your 

computer.

Operations on the Book page screen
On the Book page screen, the following operations can be 
performed.

Size indicator
Current page number/
total page number

Button Operation

> button To proceed to the next page (press); 
jump 10 pages ahead of the current page 
(press and hold).

< button To return to the previous page (press); 
jump 10 pages back from the current page 
(press and hold).

Number 
buttons

To jump to the selected page (press) (  page 
40);
Jump to the final page (press and hold 0); jump 
to the first page (press and hold 1); jump to any 
other page corresponding to the button 
number(s) (press and hold 2 -9).
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Button Operation

 (size) 
button

To zoom in/out a page.
Every time you press  (size), the page is 
magnified in steps and returns to the original 
scale after the maximum magnification.
• When reading an eBook or Text file: 

The scale switches in 3 steps ( , ,  – indicated 
at the bottom of the screen).

• When reading a PDF file: 
The scale switches between “Fit width” (page fits 
the width of window) and “Fit Visible” (texts and 
graphics fit the width of window).

• By pressing and holding  (size) for a few 
seconds, screen orientation can be switched 
(vertically/horizontally). (  page 41)

 (MARK) 
button

To create/remove a bookmark on the current 
page (press) (  page 47, 49); 
Jump to the All Bookmark screen (press and hold).

MENU button To close the page and return to the Option menu.

To use the link tool of eBooks/PDF files on the 
Reader
When an eBook or a PDF file is displayed, you can use the 
embedded link tool.
The link appears highlighted on the screen. Press Enter to 
open the linked content or jump to the linked page.

Press / to select the desired link, 
and press / to return to the 
previously displayed page.

Link
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Jumping to the specified number page 
directly

You can jump directly to a page by inputting the page 
number with the number buttons.

 On the Book page screen, press the number buttons 
to input the page number.
The input page number appears in the center of the 
page.

To clear the input page number, press .

 Press Enter. 
The page of the input page number appears.

Hint
• By pressing MENU, the previous screen appears. You can input 

the page number again.
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Switching screen orientation (vertical/
horizontal)

Screen orientation (including menu screens) can be 
switched in the following 2 ways.
• Press and hold  (size) on a menu screen or a Book page screen.
 Press and hold  (size) again to switch back.
• Configure the setting from the Setting menu. (  page 58)

About screen division when screen orientation 
is set to horizontal
When set to horizontal, the Book page is divided into 2 parts 
(upper and lower). To display the lower part, press >.

>

<

Displaying 
upper half

Displaying 
lower half

Position 
indicator
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Displaying the book information

You can display the book information, such as the title, 
author, book cover thumbnail, etc.

 In the Option menu, press / to select “Info,” then 
press Enter.
The book information appears.
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Sorting the Book list

On the Book list of “Books by Title”, books are sorted by title 
alphabetically. You can also sort books by author or date. 
If the contents of the book on the Reader and the memory 
card exceed 30 items, the Index menu appears. The Book 
list can be further sorted by selecting the category item in 
the Index menu.

 In the Home menu, press / to select “Books by 
Title,” “Books by Author” or “Books by Date,” then 
press Enter.
The Index menu appears. (  page 45)
The Index menu does not appear if the contents of the 
book on the Reader and the memory card is less than 
30 items. In this case, press < to display the Index 
menu.

 Hint
• If you select “Books by Date,” the category items of the Index 

menu are different from above. (  page 45)
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 Press / to select how to sort the Book list, then 
press Enter.

 Press / to select the desired book from the list, 
then press Enter.
The Option menu appears.

 Press / to select how to open the book, then 
press Enter.
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About the Index menu

Index menu of “Books by Date”Index menu of “Books by Title”  
and “Books by Author”

The number of 
books in the 
category and 
the page 
number in the 
Book list

Categories

When selecting “Books by Title” and “Books by 
Author”
You can select the first character of the book’s title or author. A Book 
list sorted alphabetically by title or author, starting with the selected 
characters, appears.

When selecting “Books by Date”
You can select the date that books are transferred to the Reader and 
the memory card. A Book list sorted by transferred date appears.
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Selecting a book from the Collection list

You can select and read a book from the list of collections 
created on eBook Library.

Hint
• For details on how to create or transfer a collection, refer to the 

eBook Library Help.

 In the Home menu, press / to select “Collections,” 
then press Enter.
The Collection list appears.

 Press / to select the desired collection from the 
list, then press Enter.
The Book list appears.

 Select the desired book from the list, then press 
Enter.

46 US



PRS-505.GB.3-277-508-01(2)

Creating a bookmark on a page

You can create a bookmark on a page you may wish to 
return to.

 On the Book page screen, press  (MARK) on the 
desired page.
The mark appears in the top right corner of the page.

Bookmark

If you press  (MARK) again, the bookmark will be 
removed.

Note
• When creating a bookmark, the Reader records the current page 

and the current page scale. Therefore, even on the same page, if 
the scale is switched and another bookmark created, the 
bookmarks will be stored at their respective scales.
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To open the desired page from the Bookmark list

 In the Option menu, press / to select 
“Bookmarks,” then press Enter.
The Bookmark list appears.

 Press / to select the desired page, then press 
Enter.

Hint
• Bookmarks can also be created in the eBook Library.
 The bookmarks created on the Reader or eBook Library will be 

retained when you transfer books between the Reader and eBook 
Library.

 If you transfer a book to eBook Library from the Reader, the 
bookmarks created on the Reader will be also transferred to eBook 
Library, and vice versa. 
However, if you transfer a book to a location where the same book 
exists, the bookmarks will not be overwritten.
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To remove all bookmarks in the current book

 In the Option menu, press / to select “Utilities,” 
then press Enter.

 Press / to select “Remove All Bookmarks,” then 
press Enter.
All bookmarks in the current book are removed.
Note

• Confirm carefully before removing bookmarks.

To select from the list of all bookmarks on the 
Reader

 In the Home menu, press / to select “All 
Bookmarks,” then press Enter.
The list of all bookmarks on the Reader appears.

 Press / to select the desired page, then press 
Enter.

Hint
• The All Bookmark list can also be displayed by pressing and 

holding  (MARK).
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Reading previously displayed pages

The Reader stores all displayed pages in memory for easy 
recall at any time.

 On the Book page screen, press .
As you press  repeatedly, previously displayed pages 
appear in reverse order.

To show the displayed page history

 In the Option menu, press / to select “History,” 
then press Enter.
The History list appears.

Hint
• The History list can store the histories up to 100 pages.

To clear History

 In the Option menu, press / to select “Utilities,” 
then press Enter.

 Press / to select “Clear History,” then press Enter.
History data of the current book is cleared.
Note

• Confirm carefully before clearing History.
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Playing Audio Files
Playing audio files transferred from your 
computer

Un-encrypted MP3 and AAC files can be played back on the 
Reader.
You can also read books while listening to an audio file. (  
page 53)
When listening to audio files, connect the optional 
headphones to the headphone jack.

 In the Home menu, press / to select “Audio,” then 
press Enter.
The Audio list appears.

Indicates that 
content is stored 
on a memory 
card.

: “Memory 
Stick Duo”

: SD Memory 
Card

Thumbnails of 
pictures (if 
contained on files)

Number tabs

 indicator

 Hints
• The content on the memory card also appears in the Audio list.
• In addition to /, you can also select an item by pressing the 

same number button as indicated on the number tab.
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• To display the rest of the list, press > (repeatedly).
• If an invalid operation is performed,  appears at the bottom of 

the screen.
• If an audio file is played, “Now Playing” can be selected on the 

Home menu and the Playback screen can be displayed.
• The Now Playing icon in the Home menu changes when an audio 

file is being played.

 Press / to select the desired track from the list, 
then press Enter.
Playback starts.
Tracks are played in alphabetical order.

To stop playback, press Enter.

Operations on the Playback screen
On the Playback screen, the following operations can be 
performed.

Playback indicator

Picture area

Track name
Artist name

Album name
Elapsed playback 
time

Volume indicator

Total time of the 
current track

Current track 
number/total 
track number

Status bar
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Button Operation

> button To skip to the next track.
< button To skip to the previous track.

/ To rewind/fast-forward the track.

Enter button To stop/restart playing the track.

VOLUME +/– 
buttons

To adjust the volume.

Reading books while playing an audio file

You can read books while listening to an audio file.

 In the Home menu, press / to select “Audio,” then 
press Enter.
The Audio list appears.

 Press / to select the desired track from the list, 
then press Enter.
Playback starts.

 Press MENU 2 times to return to the Home menu.

 Press / to select “Books by Title,” then press Enter.
The Book list appears.

 Press / to select the desired book from the list, 
then press Enter.
The Option menu appears.
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 Press / to select how to open the book, then 
press Enter.
The Book page screen appears.
While an audio file is played, the volume indicator  
appears at the bottom of the screen.

Hint
• To stop playback, press MENU 3 times to return to the Home 

menu, select “Now Playing” using / and Enter, then press Enter 
on the Playback screen.
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Viewing Pictures
Viewing pictures transferred from your computer

BMP/JPEG/GIF/PNG files can be viewed on the Reader.

 In the Home menu, press / to select “Pictures,” 
then press Enter.
The Picture list appears.

Indicates that 
content is stored 
on a memory 
card.

: “Memory 
Stick Duo”

: SD Memory 
Card

Thumbnails

Number tabs

 indicator

	 Hints
• The content on the memory card also appears in the Picture list.
• In addition to /, you can also select an item by pressing the 

same number button as indicated on the number tab.
• To display the rest of the list, press > (repeatedly).
• If an invalid operation is performed,  appears at the bottom of 

the screen.
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 Press / to select the desired picture from the list, 
then press Enter.
The Picture appears.

Operations on the Picture viewer
On the Picture viewer, the following operations can be 
performed.

Current picture number/
total picture number

Size indicator

Button Operation

> button To display the next picture.

< button To display the previous picture.

 (size) button To zoom in/out a page.
Every time you press  (size), the picture is 
magnified in steps and returns to the original 
scale after the maximum magnification.
The scale switches in 3 steps ( , ,  – 
indicated at the bottom of the screen).

Enter button To restore the original scale when the picture 
is magnified.
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To scroll the magnified picture
If you zoom in the picture by pressing  (size), / / /  
appear at the edges of the screen.
Press /// to scroll the screen.

To view a slideshow of pictures
You can view a slideshow of pictures.
With the slideshow set to on, select the desired picture with 
which to start the slideshow from the Picture list.
The slideshow setting can be configured from the Setting 
menu (  page 60).
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Settings

Setting screen orientation
Screen orientation (including menu screens) can be set to 
vertical/horizontal.

 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

 Press / to select “Orientation,” then press Enter.
The orientation is switched from vertical to horizontal.
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Setting the Date and Time
You can set the date and time displayed on the Reader.

 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

 Press / to select “Date and Time,” then press Enter.

 Press / to select “Year,” “Month,” “Date,” “Hour,” 
and “Minute,” then press the number buttons to 
input the date and time.

 Press / to select “OK,” then press Enter.

Hint
• When you connect the Reader to your computer with eBook 

Library started, the date and time of the Reader is automatically 
synchronized with your computer clock.
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Setting the Slideshow
Follow the steps below to configure the slideshow settings.

 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

 Press / to select “Slideshow,” then press Enter.
The Slideshow setting screen appears.

 Press Enter repeatedly to select “Off” or “On.”
The setting switches from “Off” to “On,” and the 
slideshow setting is activated.

 Press // to select “Slide Duration,” then press 
the number buttons to input the duration time.
“Slide Duration” can be set up to 60 seconds in 1 
second increments.

 Press ///	to select “OK,” then press Enter.

Notes

• The default setting of Slideshow is “Off.”
• When a large size picture is displayed, it may take longer to display 

the picture than the indicated setting time on “Slide Duration.”
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Setting the Sleep Mode (Resume 
Function)
You can set the Reader to automatically enter sleep mode. 
In sleep mode, the Reader automatically turns off if no 
operation is performed for 60 minutes (resume function).

 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

 Press / to select “Sleep Mode,” then press Enter.
The Sleep Mode setting screen appears.

 Press Enter repeatedly to select “Off,” or “On.”
Off: The Reader does not go into sleep mode.
On: The Reader automatically enter sleep mode.

 Press / to select “OK,” then press Enter.
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Notes

• The default setting of Sleep Mode is “On.”
• In the following states, the Reader does not automatically turn off if 

no operation is performed for 60 minutes.
– When connecting the computer using the supplied USB cable
– When connecting the AC Adaptor for Reader (AC-S5220E) 

(optional) to charge
– When playing audio files

Hint
• To reduce the power consumption, the Reader provides the 

following two modes. 
– Sleep Mode:
 Reader can be set to automatically enter Sleep Mode after a 

period of inactivity. Once in Sleep Mode, the Reader goes into a 
power savings mode and prevents any unintended keypad input. 
To turn Reader on again, slide the Power switch and Reader will 
immediately resume to show the previously displayed screen.

– Device Shutdown: 
 Reader can be set to enter Device Shutdown mode. Once in 

Device Shutdown Mode, the Reader will no longer consume 
power and conserve it’s battery for an extended period of time. To 
turn Reader on again, slide the Power switch, and the start-up 
screen will appear in a few moments. (  page 66)
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Setting the Advanced Settings
You can lock the Reader, format the built-in flash memory, 
and shut down the Reader.

Locking the Reader

You can lock the Reader by setting a password.
Follow the steps below.

 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

 Press / to select “Advanced Settings,” then press 
Enter.
The Advanced Settings menu appears.

 Press / to select “Device Lock,” then press Enter.
The Device Lock setting screen appears.

 Press Enter repeatedly to select “Off” or “On.”
The setting switches from “Off” to “On,” and the Device 
Lock setting is activated.

Note

• If the Device Lock is activated, the Reader is not recognized on 
your computer and the content cannot be transferred. 
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 Press // to select “Code,” then press the 
number buttons to input the password.
The 4-digit password is set.

 Press /// to select “OK,” then press Enter.

Once the password is set, next time you turn on the Reader, 
the screen asking for the password appears. 
Press the number buttons to input the password, press  to 
select “OK,” then press Enter. 

Note

• Be careful not to forget the password.
 If you lost your password, please call Sony Support 1-(866)-962-

7669.
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Formatting the internal memory

You can format the built-in flash memory of the Reader. If 
the memory is formatted, all content will be erased.

Note

• Be sure to verify the content in memory prior to formatting and 
transfer any necessary content to the hard disk of your computer or 
other device.

 In the Home menu, press / to select “Settings,” 
then press Enter.
The Settings menu appears.

 Press / to select “Advanced Settings,” then press 
Enter.
The Advanced Settings menu appears.

 Press / to select “Format Internal Memory,” then 
press Enter.

 Press  (MARK) to format the built-in flash memory 
of the Reader.

65 US



PRS-505.GB.3-277-508-01(2)

Shutting down Reader

If you will not be using the Reader for several days, the 
power consumption of the battery can be minimized by 
shutting down the Reader.

 In the Home menu, press / to select “Settings,” 
then press Enter.
The Settings menu appears.

 Press / to select “Advanced Settings,” then press 
Enter.
The Advanced Settings menu appears.

 Press / to select “Device Shutdown,” then press 
Enter.

 Press  (MARK) to shut down the Reader.

Notes

• When turning on by sliding the POWER switch from this state, the 
Reader may take a few moments to turn on.

• When you connect the Reader to your computer after shutting 
down, it is necessary to turn on the Reader again. Otherwise, it 
takes about 40 minutes until  (indicating connection via USB) is 
displayed, and you will not be able to turn on the Reader by the 
POWER switch during this time. The indicator lights up in red while 

 is not displayed, and the Reader is charged.  In this case, 
disconnect the USB cable from the Reader, then turn on the 
Reader and reconnect it.
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Checking Version Information for 
Reader
The product name and the firmware version of the Reader 
can be displayed.

 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

 Press / to select “About,” then press Enter.
The About screen appears.
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Troubleshooting

Troubleshooting
If the Reader does not function as expected, try the 
following steps to resolve the issue.

 Reset the Reader by pressing the Reset button with 
a small pin or clip.
The content and settings stored on the Reader are not 
affected by resetting, and no information is erased.
After pressing the Reset button, turn on the Reader by 
sliding the POWER switch.

Note

• When you connect the Reader to your computer after a reset, it is 
necessary to turn on the Reader again. Otherwise, it takes about 
40 minutes until  (indicating connection via USB) is displayed, 
and you will not be able to  turn on the Reader by the POWER 
switch during this time. The indicator lights up in red while  is 
not displayed, and the Reader is charged.  In this case, 
disconnect the USB cable from the Reader, then turn on the 

 Reader and reconnect it.

 Check the symptoms in “Troubleshooting.”
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 Check for information about the issue in eBook 
Library Help.

 Look for information about the issue on one of the 
support Web sites.
http://www.sony.com/readersupport

 If the approaches listed above fail to resolve the 
issue, please call Sony Support 1-(866)-962-7669.

Power
Symptom Cause or corrective action

Battery life seems 
short.

 The operating temperature is below 
5 °C (41 °F). This is due to the 
battery characteristics and not a 
malfunction.

 You have not used the Reader for a 
prolonged period. Efficiency of the 
battery will be improved by 
repeatedly charging and discharging.

 The battery needs to be replaced. 
Consult your nearest Sony Service 
Center.

 The battery has not been given 
enough time to charge fully.

	 Charge the battery until the indicator 
goes off. (The battery icon does not 
indicate remaining battery power 
during charging.)
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Symptom Cause or corrective action

The Reader cannot 
be turned on.

 Moisture condensation may have 
occurred. Wait for a few hours and 
then turn on the Reader.

 If the battery has been fully depleted, 
connect to your computer via USB 
and charge the battery (  page 17). 
If the battery has fully been depleted, 
it takes about 40 minutes until  
(indicating connection via USB) is 
displayed, and you will not be able to  
turn on the Reader by the POWER 
switch during this time. In this case, 
wait until  is displayed. The 
indicator lights up in red while  is 
not displayed, and the Reader is 
charged.

Screen
Symptom Cause or corrective action

It takes time for the 
display to appear.

 In a cold place such as outdoors, it 
may take time for the display to 
appear.

	 This is due to the display 
characteristics and not a malfunction.

The Reader 
authorization/de-
authorization is not 
possible with 
CONNECT eBooks.

 The Reader authorization/de-
authorization is not possible with 
CONNECT eBooks if “Device Lock” 
of the Reader is set to “On.” Set it to 
“Off,” then authorize/de-authorize the 
Reader.

Continued

Power (continued)
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Reading/playing/viewing contents
Symptom Cause or corrective action

A book cannot be 
read.

 A book with copyright protection 
cannot be read on any device other 
than the authorized one.

An audio file cannot 
be played back.

 Audio files that are not supported by 
the Reader cannot be played. For 
details on supported audio files, refer 
to  page 51.

Sound is not output.  Raise the volume if it is set low.

 If sound is not output through 
headphones, make sure the 
headphone plug is firmly inserted in 
the headphone jack.

A picture cannot be 
displayed.

 Picture files that are not supported 
by the Reader cannot be viewed. For 
details on supported picture files, 
refer to  page 55.

 A picture of large size may not be 
displayable, and its file will not appear 
in the list. Delete the picture file using 
eBook Library.

The data on 
Continue Reading, 
Bookmark or History 
of some files is 
missing.

 If the file status has changed (such 
as in the following cases), the data 
on Continue Reading, Bookmark or 
History may be deleted.
• A Text/RTF/PDF file is edited.
• An eBook purchased with a authorized 

Reader is read on another de-
authorized Reader by memory card 
transfer.
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Connection to the computer
Symptom Cause or corrective action

The Reader cannot 
be operated during 
USB connection.

 The Reader cannot be operated 
while it is connected to a computer.

The Reader cannot 
be recognized.

 Is the power of the Reader turned on? Is 
the USB cable connected properly?

	 Verify the above and try again.

 Are you using a USB hub or USB 
extension cable?

	 Connecting the Reader via a USB 
hub or extension cable may not work 
and is not supported. Connect the 
USB cable directly to the computer.

 Verify that  (indicating connection via 
USB) is displayed at the top of the 
Reader’s screen. If the Reader still cannot 
be recognized, disconnect the USB cable 
from the Reader, then reconnect it after a 
while.

 If “Device Lock” of the Reader is set 
to “On,” set it to “Off.” If the Reader is 
locked, it will not be recognized on 
your computer.
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Symptom Cause or corrective action

Content cannot be 
transferred to the 
Reader from your 
computer.

 The USB cable is not connected 
properly. Disconnect the USB cable, 
then reconnect it.

 There is not enough free space on 
the Readers memory. Transfer any 
unnecessary content back to eBook 
Library, then delete it to increase free 
space on the Reader.

There is no response 
from eBook Library 
during 
communication with 
the Reader.

 Disconnect the USB cable from the 
Reader, then reconnect it.

The Reader 
becomes unstable 
while it is connected 
to the computer.

 Are you using a USB hub or USB 
extension cable?

	 Connecting the Reader via a USB 
hub or extension cable may not work 
and is not supported. Connect the 
USB cable directly to the computer.

The Reader’s battery 
cannot be charged. 
(The indicator does 
not light up.)

 Is the USB cable connected 
properly? Verify and try again.

 Are you using a USB hub or USB 
extension cable? Connecting the 
Reader via a USB hub or extension 
cable may not work and is not 
supported. Connect the USB cable 
directly to the computer.

Connection to the computer (continued)
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eBook
Symptom Cause or corrective action

An eBook cannot be 
read.

 You may not have signed up for the 
service or authorized which is 
necessary for reading eBooks. 
Authorize your computer and the 
Reader.

 You may have tried to read the 
content owned by another user. 
The content owned by another 
user cannot be read.

 The authorization data may be 
damaged caused by a shut down 
while reading an eBook. De-
authorize your computer and the 
Reader, then authorize again.
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Memory card
Symptom Cause or corrective action

Content on a 
memory card cannot 
be read/played/
viewed.

 Check that the memory card is 
inserted in the Media slot in the 
correct direction.

 Check to see that you are using a 
memory card that is supported by 
the Reader.

 Clean the terminal area of memory 
card gently with a soft cloth if it is 
dirty.

Content cannot be 
transferred to a 
memory card.

 Release the erasure prevention 
switch if it is locked.

 There is not enough free space on 
the memory card. Delete 
unnecessary data.

A memory card 
cannot be 
recognized.

 A memory card which is not 
formatted with FAT may not be able 
to be recognized on eBook Library.

	 When formatting a memory card, 
format it using the formatter supplied 
with the memory card, or using 
Windows Explorer by specifying FAT.
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Restoring default settings

All default settings of the Reader can be restored.

Notes

The following occurs when you restore the default settings.
• The screen orientation setting will be vertical.
• The password will be erased and the device lock released.
• The Slideshow setting will be set to “Off” and its duration time set 

to 5 seconds.
• The volume will return to the default level.

 In the Home menu, press / to select “Settings,” 
then press Enter.
The Setting menu appears.

 Press / to select “Restore Defaults,” then press 
Enter.
The Restore Defaults screen appears. 
If “Device Lock” (  page 63) is set to “On,” the screen 
asking for the password appears. Input the password, 
then select “OK.”

 Press  (MARK) to restore default settings.
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Uninstalling eBook Library
To uninstall the supplied software from your computer, follow 
the procedures below.

Note

• Before uninstalling, de-authorize your computer if it is authorized.
 For details on de-authorization, refer to the eBook Library Help.

 Click “Start” – “Control Panel.”

 Double-click “Add/Remove Programs.” *1

 Click “eBook Library by Sony” in the “Currently 
Installed Programs” list, then click “Remove.” *2

Follow the on-screen instructions and restart your 
computer. The uninstallation is complete when the 
computer has restarted.

Uninstalling PRS-505 User’s Guide
1 Click “Start”-“Control Panel.”

2 Double-click “Add/Remove Programs.” *1

3 Click “PRS-505 User’s Guide” in the “Currently Installed 
Programs” list, then click “Remove.” *2

Follow the on-screen instructions and restart your computer. The 
uninstallation is complete when the computer has restarted.

*1 “Uninstall a program” or “Programs and Features” in the case of 
Windows Vista.

*2 “Uninstall” in the case of Windows Vista.
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Other Information

Updating the Reader’s Firmware
By updating the Reader’s firmware, you can ensure your 
Reader has the latest features. The latest firmware updates 
can be performed from the update menu on eBook Library 
from “Help” – “Check for Updates.”
For details on updates, refer to the eBook Library Help or 
the following website.
http://www.sony.com/readersupport
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About Books Pre-installed on 
Reader
The Reader is pre-installed with sample data so that you 
can try it out right away. The pre-installed sample data is for 
the purpose of trial reading, viewing and listening.
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Notes on Reader Disposal
The built-in rechargeable battery of the Reader is recyclable. 
Do not remove the battery yourself, consult “Sony Portable 
Reader System Support Center” (  page 83).
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Precautions

Owner’s Record
The model and serial numbers are located on the back of 
the unit. Record the serial number in the space provided 
below. Refer to these numbers whenever you call upon your 
Sony dealer regarding this product.
Model No. __________________________
Serial No. __________________________
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For Customers in the USA
INFORMATION:
This equipment has been tested and found to comply with 
the limits for a Class B digital device, pursuant to Part 15 of 
the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful 
interference to radio communications.
However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of 
the following measures:
– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and 

receiver.
– Connect the equipment into an outlet on a circuit different 

from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician 

for help.
You are cautioned that any changes or modifications not 
expressly approved in this manual could void your authority 
to operate this equipment.
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If you have any questions about this product:
Visit:
www.sony.com/readersupport
Contact:
Sony Portable Reader System Support Center at 1-(866)-
962-7669
Write:
Sony Customer Information Services Center
12451 Gateway Blvd., Fort Myers, FL 33913

Declaration of Conformity

Trade Name: SONY
Model No.: PRS-505
Responsible Party: Sony Electronics Inc.
Address: 16530 Via Esprillo, 

San Diego, CA 92127 
U.S.A.

Telephone Number: 858-942-2230

This device complies with Part 15 of the 
FCC Rules. Operation is subject to the 
following two conditions: (1) This device 
may not cause harmful interference, and 
(2) this device must accept any 
interference received, including 
interference that may cause undesired 
operation.
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For Customers in the USA and Canada
RECYCLING LITHIUM-ION BATTERIES
Lithium-ion batteries are recyclable.
You can help preserve our environment by returning 
your used rechargeable batteries to the collection 
and recycling location nearest you.

For more information regarding recycling of rechargeable 
batteries, call toll free 1-800-822-8837, or visit http://www.
rbrc.org/.

Caution: Do not handle damaged or leaking Lithium-ion 
batteries.

On safety

• Do not insert any foreign objects in the DC IN jack of the 
Reader.

• Be sure not to short-circuit the terminals of the Reader 
with metallic objects.

On installation

• Never subject the Reader to extremes of light, 
temperature, moisture or vibration.

• Never wrap the Reader in anything when it is being used 
with the AC power adapter. Heat build-up in the Reader 
may cause malfunction or damage.
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On heat build-up

Heat may build up in the Reader while charging, or if it is 
used for an extended period of time.

On the headphones

Road safety
Do not use headphones while driving, cycling, or operating 
any motorized vehicle. It may create a traffic hazard and is 
illegal in many areas. It can also be potentially dangerous to 
play at a high volume while walking, especially at pedestrian 
crossings. You should exercise extreme caution or 
discontinue use in potentially hazardous situations.

Preventing hearing damage
Avoid using the headphones at a high volume. Hearing 
experts advise against continuous, loud and extended play. 
If you experience a ringing in your ears, reduce the volume 
or discontinue use.

Caring for others
Keep the volume at a moderate level. This will allow you to 
hear outside sounds and to be considerate to the people 
around you.

Warning
If lightning occurs while you are using the Reader, take off 
the headphones immediately.
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Notes on memory cards

About “Memory Stick Duo”
“Memory Stick Duo” is a high-capacity compact IC recording 
media. Not only can you exchange data among “Memory 
Stick Duo” compatible devices, but also you can use as an 
external removable data storage.

About SD Memory Card
SD Memory Card complies with compact memory card 
standard and is commonly used as a storage media for 
digital still cameras.

For details on memory cards supported by the Reader, refer 
to “Inserting a Memory Card” on  page 19.

Notes on handling memory cards
• When using miniSD Card on the Reader, an adaptor (sold 

separately) is required.
• The Reader does not comply with the following:

− MagicGate standard.
− copyright protection of SD Memory Cards.
− high-speed transfer of SD Memory Cards.
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• You cannot record or delete data stored in a memory card 
when its erasure prevention switch is locked.

 

• Keep a memory card in its case when you carry or store it.
• Do not touch the connector of a memory card with bear 

hands or metallic objects.
• Do not bend, drop, or subject a memory card to excessive 

shock.
• Do not disassemble or modify a memory card.
• Do not allow a memory card to get wet.
• Avoid the following to prevent data damage. Sony does not 

provide any guarantee for damaged data.
− Remove a memory card or turn off the Reader while reading or 

writing data.
− Operate the Reader in the location where static charge or 

electrical noise is present.

• Do not use a label other than the dedicated one in the 
label area.

• Do not use or store the Reader in a location subject:
− extreme high temperature, such as in a sun-heated car.
− direct sunlight.
− high humidity or places with corrosive substances.
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On software

• Copyright laws prohibit reproducing the software or the 
manual accompanying it in whole or in part, or renting the 
software without the permission of the copyright holder.

• In no event will SONY be liable for any financial damage, 
or loss of profits, including claims made by third parties, 
arising out of the use of the software supplied with this 
Reader.

• In the event a problem occurring with this software as a 
result of defective manufacturing, SONY will replace it. 
However, SONY bears no other responsibility.

• The software provided with this Reader cannot be used 
with equipment other than that which is so designated.

• Please note that, due to continued efforts to improve quality, 
software specifications may be changed without notice.

• Operation of this Reader with software other than that 
provided is not covered by the warranty.

• The ability to display the languages on your eBook Library 
will depend on the OS installed on your computer. For 
better results, please ensure that the installed OS is 
compatible with the desired language you want to display.
− We do not guarantee all the languages will be able to be 

displayed properly on your eBook Library.
− User-created characters and some special characters may not 

be displayed.

• Explanations in this manual assume that you are familiar 
with the basic operations of Windows. For details on the 
use of your computer and operating system, please refer 
to the respective manuals.
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On Cleaning
• Clean the case of the Reader with a soft cloth, such as a 

cleaning cloth for eyeglasses.
• If the case of the Reader becomes very dirty, clean it with 

a soft cloth slightly moistened with water or a mild 
detergent solution.

• Do not use any type of abrasive pad, scouring powder, or 
solvent, such as alcohol or benzene, as it may mar the 
finish of the case.

• Be careful not to let water get into the Reader from the 
opening near the connector.

• Clean the headphone plug periodically.

If you have any questions or problems concerning the 
Reader, consult your nearest Sony dealer.

Notes

• Recorded content is limited to private use only. Use of the 
content beyond this limit requires permission of the copyright 
holders.

• Sony is not responsible for incomplete recording/downloading or 
damaged data due to problems of the Reader or computer.
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On Copyrights

The contents of each book pre-installed on this product 
are copyrighted works, edited with the cooperation of the 
publisher and editor hereto mentioned.
Copyright laws prohibit copying the data of this product or 
the contents of this manual (illustrations, related 
documents, etc.) in whole or in part without the permission 
of the copyright holder. Additionally, use of the data of this 
product or the contents of this manual is not allowed 
without Sony’s permission except for personal use.

• SONY and the SONY logo are registered trademarks of Sony 
Corporation.

• BBeB, BBeB Book, and their logos are trademarks of Sony 
Corporation.

• “Memory Stick,” “Memory Stick Duo,” “Memory Stick PRO Duo,” 
and their logos are trademarks of Sony Corporation.

• Bitstream is a registered trademark, and Dutch, Font Fusion, 
and Swiss are trademarks, of Bitstream Inc.

• Microsoft, Windows, Windows Vista and Windows Media are 
trademarks or registered trademarks of Microsoft Corporation in 
the United States and / or other countries.

• Adobe, Adobe Reader and Adobe PDF are trademarks or 
registered trademarks of Adobe Systems Incorporated in the 
United States and/or other countries.

• MPEG Layer-3 audio coding technology and patents licensed 
from Fraunhofer IIS and Thomson.
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• This product uses MontaVista Software, Inc.’s MontaVista(R) 
Linux(R) Professional Edition as the operating system. 
COPYRIGHT ©1999-2006 MONTAVISTA 
SOFTWARE, INC. ALL RIGHTS 
RESERVED. 
http://www.mvista.com/

• MontaVista is a registered trademark of MontaVista Software, Inc.
• This product includes software developed by the OpenSSL 

Project for use in the OpenSSL Toolkit.   
(<http://www.openssl.org/>)  Copyright © 1998-2006 The 
OpenSSL Project. All rights reserved. This product includes 
cryptographic software written by Eric Young (eay@cryptsoft.
com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com). For details on OpenSSL License, refer to 
“openssl.txt” on the CD-ROM.

All other system names and product names appearing in this 
document are generally the registered trademarks or trademarks 
of their respective manufacturers. Further, the trademark TM and 
registered trademark ® symbols are not indicated throughout this 
document.

Program ©2006, 2007 Sony Corporation
Documentation ©2006, 2007 Sony Corporation

About GNU GENERAL PUBLIC LICENSE

Dear customers
Thank you for purchasing this product.
Included with this product is the following software which 
applies to GPL/LGPL. You may obtain, modify and 
redistribute the source codes of the software.

bash
fileutils
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findutils
gcc
glib
glibc
grep
hardhatutils
hostname
mkcramfs
mtd-utils
mtools
ncurses
pam
procps
psmisc
sed
shellutils
sysutils
sysvinit
tar
textutils
time
util-linux

These source codes are available on the web site.
Access the following web site to download.
http://www.sony.net/Products/Linux/
Note that Sony accepts no inquiries concerning the contents 
of these source codes.

For details on GNU GENERAL PUBLIC LICENSE, refer to 
“gpl.txt” and “lgpl.txt” on the CD-ROM.
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Specifications

Model name
PRS-505

Power source
Built-in rechargeable battery: DC 3.7 V
AC power adapter: DC 5.2 V

Battery life (continuous playback)
Approx. 7500 pages (when the battery is fully charged)

User available capacity
Approx. 192MB
Available storage capacity of the Reader may vary.

Operating temperature
5 to 35 °C (41 to 95 °F)

Dimensions (w/h/d)
Approx. 6.9 x 4.8 x 0.3 inches
(maximum, without soft cover)

Mass
Approx. 9 oz (without soft cover)

Optional Accessories
AC Adaptor for Reader: AC-S5220E

Design and specifications are subject to change without 
notice.
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À propos des manuels
Le Guide de démarrage et le présent Guide de l’utilisateur 
au format PDF sont livrés avec le Reader. Après avoir 
installé votre logiciel eBook Library à l’aide du CD-ROM 
fourni, vous pouvez également vous reporter à l’Aide eBook 
Library.

Navigation dans le Guide de l’utilisateur

Ce Guide de l’utilisateur au format PDF peut être consulté 
sur un ordinateur, mais également sur le Reader.

Pour naviguer dans le Guide de l’utilisateur 
avec votre ordinateur
Cliquez sur le menu Démarrer en bas à gauche du Bureau, 
puis sélectionnez « Tous les programmes » – « Reader » – 
« PRS-505 User’s Guide » pour lancer Adobe Reader et 
ouvrir le Guide de l’utilisateur. 
Pour plus d’informations sur l’utilisation du logiciel Adobe 
Reader, reportez-vous à l’Aide Adobe Reader.

Conseil
• Vous devez installer Adobe Reader, version 5.0 ou ultérieure, pour 

visualiser le Guide de l’utilisateur. Vous pouvez télécharger 
gratuitement Adobe Reader directement depuis le site Adobe 
(www.adobe.com).

FR
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Pour naviguer dans le Guide de l’utilisateur 
avec le Reader
Dans le menu d’accueil, sélectionnez « Books by Title » – « User’s 
Guide » dans la liste de livres. Vous pouvez ouvrir le Guide de 
l’utilisateur en sélectionnant « Option Menu » – « Begin ».

Lien PDF

MENU

1

2

3

4

5

6

7

8

9

0

MENU

1

2

3

4

5

6

7

8

9

0

Touche  (taille)

Conseils
• Le signe  sur le Guide de l’utilisateur indique un lien. Pour sélectionner 

le lien de votre choix, utilisez les touches ////Entrée. Appuyez sur 
/, puis appuyez sur Entrée pour ouvrir la page souhaitée.

• Pour effectuer un zoom dans la page, appuyez sur la touche  (taille).

Pour plus d’informations sur l’ouverture de livres ou de fichiers 
PDF, voir  pages 35, 39.

Utilisation de l’Aide eBook Library
Pour plus d’informations sur l’utilisation du logiciel eBook 
Library, comme par exemple, sur l’importation de livres sur 
votre ordinateur ou bien encore le transfert de livres vers le 
Reader, reportez-vous à l’Aide eBook Library. 
Suivez les étapes ci-dessous pour lancer eBook Library et parcourir l’Aide.

 Cliquez sur le menu Démarrer de votre ordinateur, puis sélectionnez 
« Tous les programmes » – « Reader » – « eBook Library ».

 Cliquez sur « Help » – « eBook Library Help » sur la barre de menus.
L’Aide apparaît.
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Présentation

Utilisation du Reader
Lisez tout d’abord le Guide de démarrage avant d’utiliser 
votre Reader. Avant toute première utilisation du Reader, 
vous devez charger la batterie et installer le logiciel dédié 
« eBook Library » sur votre ordinateur.
Une fois ces opérations effectuées, vous pouvez transférer 
le contenu de votre ordinateur vers le Reader afin de 
l’emporter partout où vous le souhaitez.

eBooks 
téléchargés*1

*2

*1	 CONNECT	eBooks	(librairie	en	ligne	e-Book)
*2	 Fichiers	Livres/Fichiers	audio/Images	dont	vous	disposez	déjà

Transfert

Chargez la batterie de votre Reader, puis installez le 
logiciel eBook Library sur votre ordinateur.

Téléchargez sur votre 
ordinateur le logiciel 
eBooks depuisla librairie en 
ligne CONNECT eBooks.

Transférez du contenu 
depuis votre ordinateur  
vers le Reader en utilisant 
eBook Library.

Profitez de ce contenu sur 
votre Reader.

Lecture/Écoute/
Visualisation

Importation

Mise en service
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Composants et commandes

Avant
 Touche Entrée*1

Appuyez sur la touche Entrée pour sélectionner 
un élément ou appliquer un réglage.

 Touches ///*1

Appuyez sur les touches  (gauche),  (haut),  (bas) 
ou  (droite) pour sélectionner un élément ou faire 
défiler l’écran.

*1	 Dans	ce	manuel,	le	fonctionnement	des	touches	////Entrée	est	
expliqué	comme	suit	:

	 (Exemple)	Appuyez	sur	les	touches	///	pour	sélectionner		
«	Away	»	dans	la	liste	de	livres,	puis	appuyez	sur	la	touche	Entrée.

Suite

Touche 
Entrée
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 Touche MENU
Permet de revenir à l’écran précédent ou d’afficher un 
menu. (  page 13)

 Touches  (page) / (>/<)
Permettent de tourner la page ou de passer au contenu 
suivant (>), et de revenir au contenu précédent (<).  
(  pages 36, 38, 53, 56)

 Touches numériques (1 – 9,0)
Permettent de sélectionner les éléments numérotés à 
l’écran ou de saisir des valeurs numériques dans le 
menu de réglage. (  pages 36, 38, 51, 55)

 Fente d’insertion de la carte mémoire SD
Permet d’insérer une carte mémoire SD (en option).  
(  page 20)

 Fente d’insertion du « Memory Stick Duo »
Permet d’insérer un « Memory Stick Duo » (en option).  
(  page 20)

 Commutateur POWER
Permet d’allumer et/ou d’éteindre le Reader. (  page 15)

 Témoin
Un témoin rouge s’allume pendant le chargement de la 
batterie et s’éteint lorsque le chargement est terminé.  
(  page 17) 
Le témoin clignote en orange lorsque le Reader accède 
à votre ordinateur via un raccordement USB.
Il clignote également en orange lors de la mise sous 
tension ou hors tension du Reader.
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 Orifices de fixation de l’étui souple
L’étui souple est mis en place lors de l’achat. (  page 12)

1

2

3

4

5

6

7

8

9

0

Se plie lors de l’utilisation

Remarque
• N’exposez pas votre Reader à des températures élevées pour 

éviter tout risque de détérioration de l’étui souple.

 Touche  (taille)
Permet d’effectuer des zooms avant/arrière sur une page 
ou une image. (  pages 39, 56)

 Touche  (MARQUE)
Permet de créer et/ou de déplacer un signet. (  page 47)

 Anneau de fixation de la dragonne
Permet d’attacher la dragonne.

 Connecteur USB
Permet de connecter le câble USB (fourni). (  page 28)

 Prise DC IN
Permet de connecter un adaptateur CA (en option).

 Conseil
• Vous pouvez charger votre Reader en le connectant à un 

ordinateur à l’aide du câble USB fourni.
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 Prise  (Écouteurs)
Permet de brancher les écouteurs (en option).  
(  page 51)

 Touches VOLUME +/– 
Permettent de régler le volume. (  page 53)
Pour activer la fonction de sourdine, maintenez les 
touches VOLUME +/– enfoncées. Pour désactiver la 
fonction de sourdine, appuyez de nouveau sur les 
touches VOLUME +/–.

Arrière

 Touche Reset
Permet de réinitialiser le Reader si aucune opération 
n’est possible. (  page 68)
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À propos du numéro de série
Le numéro de série fourni avec le Reader est requis lors de 
l’enregistrement du client. Ce numéro est inscrit sur 
l’étiquette collée au dos de votre Reader. Ne retirez jamais 
cette étiquette.

Retirer et/ou fixer l’étui souple
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Retrait de l’étui souple
 Tirez la languette de l’étui souple vers l’extérieur .
 Retirez le Reader dans le sens de .

Fixation de l’étui souple
 Insérez la languette  de l’étui souple dans l’orifice  

du Reader.
 Tirez la languette de l’étui souple dans le sens de .
 Insérez le Reader dans le sens de  pour le fixer sur 

l’étui souple.
 Vérifiez si les languettes de l’étui souple sont bien 

insérées dans les orifices du Reader.

Remarque

• Notez que la languette de l’étui souple peut se déformer si vous 
tirez trop fort dessus.
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Opérations de base

Fonctionnement des menus
Vous pouvez passer d’un écran à un autre, pour lire/écouter/
visualiser du contenu ou pour régler les paramètres, à l’aide des 
touches ////Entrée, des touches numériques ou du MENU.
Exemple : schéma de transition d’écrans du menu d’accueil 
à la liste de livres au menu d’options et à la page du livre

Appuyez sur 
les touches 
/ pour 
sélectionner 
puis appuyez 
sur Entrée.

Appuyez sur la 
touche MENU pour 
revenir à l’écran 
précédent.

Boutons numérotés 
L’élément sélectionné est surligné en noir.

Appuyez sur les touches / pour sélectionner 
« Books by Title » puis appuyez sur Entrée.

Appuyez sur les touches / 
pour sélectionner puis appuyez 
sur Entrée.

Si plus de 30 livres sont stockés, le 
menu Index apparaît. (  pages 43, 45)
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Conseils
• En maintenant la touche  (taille) enfoncée, vous pouvez changer 

l’orientation de l’écran (verticale/horizontale). (  page 41)
• En utilisant les touches numériques correspondantes, vous pouvez 

sélectionner les éléments numérotés.
• En maintenant la touche MENU enfoncée, vous pouvez revenir au 

menu d’accueil.
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Mise sous tension du Reader
Faites glisser le commutateur POWER dans le sens de  
pour mettre le Reader sous tension.

Faites glisser le 
commutateur POWER.

Le Reader s’allume.
À la première mise en service de l’appareil, après une 
réinitialisation ou lorsque que la batterie est épuisée, 
quelques instants d’attente sont parfois nécessaires avant 
que le Reader s’allume et que l’écran de démarrage 
n’apparaisse.
Le témoin s’allume en orange quand le Reader est sous 
tension.

Pour éteindre le Reader
Faites de nouveau glisser le commutateur POWER dans le 
sens de .
Le Reader s’éteint.
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À propos du mode de veille (fonction de 
reprise)
Vous pouvez configurer le Reader pour qu’il passe 
automatiquement en mode de veille. En mode de veille, le 
Reader se met automatiquement hors tension lorsqu’il reste 
inutilisé pendant 60 minutes (fonction de reprise). L’écran 
précédemment affiché apparaît lorsque vous faites glisser le 
commutateur POWER pour allumer l’appareil. 
Vous pouvez configurer le mode de veille dans le menu de 
réglages (  page 61).

Remarque

• Dans les cas suivants, le Reader ne se met pas automatiquement 
hors tension lorsqu’il reste inutilisé pendant 60 minutes.
– Lorsque l’appareil est raccordé à l’ordinateur à l’aide du câble 

USB fourni
– Lorsqu’il est raccordé à l’adaptateur CA pour le Reader 

AC-S5220E (en option) pour la charge
– Lors de la lecture de fichiers audio
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À propos du chargement de la batterie
Vous devez charger le Reader avant sa première utilisation. 
Mettez le Reader sous tension, puis chargez-le de l’une des 
deux façons suivantes.
• Raccordez l’appareil à un ordinateur via le câble USB (voir Guide 

de démarrage ou  page 27 ). 
(Temps de charge : environ 4 heures*)

• Raccordez l’appareil à une prise CA via un adaptateur CA et un 
cordon d’alimentation CA (en option). 
(Temps de charge : environ 2 heures*)
* Temps approximatif pour que la batterie soit complètement chargée.

Remarques

• Lorsque vous raccordez le Reader à votre ordinateur, l’indication 
 (connexion USB) s’affiche à l’écran du Reader. Si la batterie 

est complètement épuisée, l’indication  peut mettre environ 
40 minutes à s’afficher. Vous ne pourrez pas mettre le Reader sous 
tension à l’aide du commutateur POWER pendant ce temps. Dans 
ce cas, attendez que l’indication  s’affiche. Un témoin rouge 
s’allume lors du chargement du Reader si l’indication  ne 
s’affiche pas à l’écran.

• Si le niveau d’autonomie de l’ordinateur portable auquel vous êtes 
raccordé est faible, il est impossible de procéder à un chargement 
via une connexion USB.

• Si vous raccordez le Reader à un ordinateur portable qui n’est pas 
branché sur une prise CA, vous risquez d’épuiser la batterie de 
l’ordinateur. Ne laissez jamais votre Reader raccordé à un 
ordinateur portable qui n’est pas branché sur une prise CA 
pendant une période prolongée.

• Le raccordement du Reader via un concentrateur ou une rallonge 
USB n’est pas pris en charge et risque de ne pas fonctionner. 
Raccordez le câble USB directement à l’ordinateur.
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Vous pouvez surveiller le niveau d’autonomie grâce 
l’indicateur en bas à gauche de l’écran. Chargez de 
préférence la batterie lorsque le niveau d’autonomie est 
faible (le niveau d’autonomie est faible lorsqu’il ne reste plus 
qu’un seul segment noir affiché).

Remarque

• Si le niveau d’autonomie est faible, l’avertissement suivant 
apparaît. Mettez la batterie en charge.

 
 Si vous continuez à utiliser l’appareil sans recharger la batterie, 

l’avertissement suivant apparaît, puis le Reader s’éteint 
automatiquement.

 Chargez le Reader avant de l’allumer de nouveau.
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Insertion d’une carte mémoire
Vous pouvez insérer les cartes mémoire suivantes dans les 
fentes pour carte mémoire de votre Reader.

Remarque

• Le Reader dispose de fentes séparées pour les « Memory Stick Duo » 
et les cartes mémoire SD. Assurez-vous d’insérer la carte mémoire 
dans la fente appropriée. L’insertion de la carte mémoire dans la 
mauvaise fente peut endommager la fente ainsi que la carte mémoire.

« Memory Stick Duo »*1 « Memory Stick Duo » 
« Memory Stick PRO Duo »

Carte mémoire SD*2 Carte mémoire SD
Carte miniSD*3

*1 Le Reader n’est pas compatible avec la norme MagicGate. De plus, 
les données qui requièrent la fonction de protection des droits 
d’auteur ne peuvent pas être copiées ou lues sur le Reader.

*2 Le Reader n’est pas compatible avec la protection des droits d’auteur 
des cartes mémoire SD.

*3 Un adaptateur pour carte miniSD (vendu séparément) est requis.

Remarques

• Avec les « Memory Stick Duo » d’une capacité maximum de 8 Go, 
un contrôle de compatibilité est effectué. Cependant, la compatibilité 
avec tous les « Memory Stick Duo » n’est en aucun cas garantie.

• Avec les cartes mémoire SD d’une capacité maximum de 2 Go, un 
contrôle de compatibilité est effectué. Cependant, la compatibilité 
avec toutes les cartes mémoire SD n’est en aucun cas garantie.

• Lorsque vous insérez la carte mémoire dans le Reader, la 
reconnaissance des fichiers de contenu peut prendre quelques 
instants, surtout si la taille des fichiers de contenu stockés sur 
cette carte mémoire est importante.
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Pour insérer une carte mémoire dans le 
Reader

 Retirez les cartes factices de la fente pour « Memory 
Stick Duo » et de la fente pour carte mémoire SD.
Les cartes factices sont insérées dans la fente pour  
« Memory Stick Duo » et la fente pour carte mémoire 
SD à l’achat. Lorsque vous n’utilisez pas de carte 
mémoire, insérez la carte factice dans la fente.

Remarque

• Si la carte factice n’est pas insérée dans la fente, des corps 
étrangers risquent d’y pénétrer, ce qui peut entraîner des 
problèmes de fonctionnement ou des dommages.
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 Insérez une carte mémoire dans le sens de la 
marque  avec l’étiquette vers le haut jusqu’au 
déclic de mise en place.
Remarque

• Le Reader dispose de fentes séparées pour les « Memory Stick 
Duo » et les cartes mémoire SD. Assurez-vous d’insérer la carte 
mémoire dans la fente appropriée. L’insertion de la carte mémoire 
dans la mauvaise fente peut endommager la fente ainsi que la 
carte mémoire.

  
Marque

« Memory 
Stick Duo »

Carte 
mémoire SD

  
Marque

Remarques

• Assurez-vous d’insérer la carte mémoire dans le bon sens. Si vous 
forcez pour insérer la carte, cela peut endommager la fente.

• N’insérez jamais une carte mémoire incompatible dans l’appareil, 
vous risquez d’entraîner des problèmes de fonctionnement.

• N’utilisez jamais une carte mémoire ou un adaptateur déformé.
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Pour retirer une carte mémoire du Reader

 Appliquez une légère pression sur la carte mémoire.
Au clic, la carte mémoire est éjectée de l’appareil.

« Memory 
Stick Duo »

Carte 
mémoire SD

 Retirez complètement la carte mémoire de la fente 
pour « Memory Stick Duo » ou pour carte mémoire 
SD.

Remarques

• Ne retirez jamais la carte mémoire ou n’éteignez jamais le Reader 
pendant la lecture ou l’écriture de données, vous risquez de perdre 
des données.

• Pour plus d’informations sur l’utilisation des cartes mémoire, voir  
page 85.
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Importation de livres électroniques

Importation de eBooks depuis 
CONNECT eBooks
Vous pouvez télécharger des eBooks depuis la librairie en 
ligne « CONNECT eBooks » sur votre ordinateur.
Utilisez le logiciel dédié eBook Library pour accéder à 
CONNECT eBooks.

Remarques

• Pour télécharger des eBooks, votre ordinateur doit disposer d’un 
accès Internet.

• Vous devez autoriser votre ordinateur à accéder à CONNECT 
eBooks pour télécharger des eBooks.

 Vous devez également autoriser votre Reader à accéder à 
CONNECT eBooks pour transférer et lire des eBooks téléchargés 
sur votre Reader.

 Pour plus d’informations, reportez-vous à l’Aide eBook Library.

 Double-cliquez sur l’icône eBook Library ( ) sur le 
bureau Windows.

	 Conseil
• Vous pouvez également démarrer le logiciel eBook Library en 

cliquant sur le menu Démarrer, puis en sélectionnant « Tous les 
programmes » – « Reader » – « eBook Library ».

 Cliquez sur « eBook Store » dans l’affichage par 
source.
La zone d’affichage passe à l’affichage par stockage et 
CONNECT eBooks apparaît.
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 Suivez les instructions de la page pour acheter des 
eBooks (téléchargement).
Les eBooks téléchargés sont automatiquement 
importés dans « Library » dans l’affichage par source.

Library Contenu 
téléchargé

Affichage par source

	 Conseil
• Les eBooks achetés sont regroupés dans le dossier « Purchased » 

de la collection.

Conseils
• Vous pouvez lire les eBooks sur votre ordinateur à partir de eBook 

Library. Pour plus d’informations sur l’utilisation de eBook Library, 
reportez-vous à l’Aide eBook Library.

• L’affichage par source peut différer d’un ordinateur à un autre.
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Importation de contenu depuis 
votre ordinateur
Vous pouvez importer des fichiers de contenu stockés en 
local sur votre ordinateur dans la Library de eBook Library.

Il est possible d’importer les types de fichier de contenu 
suivants.
• Livre  

Format PDF, texte, RTF, Word*, BBeB
• Audio  

Fichiers audio au format AAC et MP3 décryptés
– Fichier MP3 (extension de fichier .mp3) 

Les spécifications suivantes sont requises pour l’importation de 
fichiers MP3. 
Débit binaire : 32 à 320 kbit/s 
Fréquence d’échantillonnage : 22,05, 44,1 kHz

– Fichier AAC (extension de fichier .mp4, .m4a, .mov ou .qt) 
Les spécifications suivantes sont requises pour l’importation de 
fichiers AAC. 
Débit binaire : 40 à 320 kbit/s 
Fréquence d’échantillonnage : 24,0, 44,1, 48,0 kHz

• Image 
Format Bitmap, JPEG, GIF, PNG

 * Les fichiers Word sont automatiquement convertis en fichiers RTF 
pendant le transfert, à condition que Microsoft Word soit installé 
sur votre ordinateur.

Pour plus d’informations sur l’importation de fichiers de 
contenu, reportez-vous à l’Aide eBook Library.
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Importation de fichiers de contenu
Vous pouvez sélectionner des fichiers de contenu stockés 
en local sur votre ordinateur et les importer dans Library.

 Cliquez sur le menu Démarrer, puis sélectionnez  
« Tous les programmes » – « Reader » – « eBook 
Library » pour lancer eBook Library.

 Cliquez sur « Import Files » dans le menu « File ».
La boîte de dialogue « Import Files » apparaît.

 Cliquez dans  la liste « Look in » pour sélectionner 
le dossier contenant le ou les fichier(s) que vous 
souhaitez importer.
Les fichiers de contenu du dossier sélectionné sont 
répertoriés.

	 Conseil
• Vous pouvez également double-cliquer sur le dossier (dans la 

liste de dossiers) pour afficher les fichiers de contenu.

 Sélectionnez le fichier de contenu que vous 
souhaitez importer.
Cliquez sur les fichiers tout en maintenant la touche Ctrl 
enfoncée pour sélectionner plusieurs fichiers à la fois.

 Cliquez sur « Open ».
Le ou les fichier(s) de contenu sont importés dans Library.

Conseil
• Vous pouvez importer simultanément tous les fichiers contenus 

dans un dossier Library en cliquant sur « Import Folder » dans le 
menu « File ».
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Transfert de contenu

Transfert de contenu vers le 
Reader depuis votre ordinateur
Vous pouvez transférer (copier) le contenu de la Library sur 
le Reader.

Remarque

• Si le Reader est verrouillé, il ne sera pas reconnu par votre 
ordinateur et le transfert de contenu sera impossible. (  page 63) 
Si le Reader est connecté à votre ordinateur, débranchez-le et 
déverrouillez le Reader en saisissant le mot de passe.

Conseils
• Le contenu de livres peut être regroupé dans la Library sous forme 

de collection, qui peut ensuite être transférées sur le Reader. Pour 
plus de détails sur la création et le transfert d’une collection, 
reportez-vous à l’aide eBook Library.

• Vous pouvez synchroniser le contenu de votre eBook Library avec 
le Reader en sélectionnant un dossier (tel que « Library » ou ses 
sous-dossiers). (  page 34) Le Reader peut être mis à jour 
automatiquement pour correspondre au contenu de la Library, lors 
du raccordement à votre ordinateur.

 Cliquez sur le menu Démarrer, puis sélectionnez  
« Tous les programmes » – « Reader » – « eBook 
Library » pour lancer eBook Library.

Suite 27 FR 



PRS-505.FR.3-277-508-01(2)

 Raccordez le Reader à votre ordinateur à l’aide du 
câble USB fourni.

Câble USB  
(fourni)

Vers le connecteur USB

« Sony’s Reader » apparaît dans l’affichage par source 
de eBook Library.
Un écran apparaît sur le Reader, indiquant que 
l’appareil est raccordé à l’ordinateur.
Remarques

• Si « Sony’s Reader » n’apparaît pas dans l’affichage par 
source après le raccordement du Reader à l’ordinateur, 
débranchez le câble USB du Reader, puis attendez quelques 
instants avant de le reconnecter.

• Lorsque vous connectez le Reader à votre ordinateur, 
l’indication  (connexion USB) s’affiche à l’écran du Reader. 
Si la batterie est complètement épuisée, l’indication  peut 
mettre environ 40 minutes à s’afficher. Vous ne pourrez pas 
mettre le Reader sous tension à l’aide du commutateur 
POWER pendant ce temps. Dans ce cas, attendez que 
l’indication  s’affiche. Un témoin rouge s’allume lors du 
chargement du Reader si l’indication  ne s’affiche pas à 
l’écran.
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 Cliquez sur « Library » dans l’affichage par source, 
puis sur  (affichage par liste).
La zone d’affichage passe à l’affichage par liste et tout 
le contenu de la Library est répertorié.

 Conseils
• Lorsque vous cliquez sur « Books », « Audio » ou « Pictures » 

dans l’affichage par source, seul le contenu correspondant 
s’affiche.

• Lorsque vous cliquez sur  (affichage par vignette), le contenu 
s’affiche sous forme de vignettes.

• Vous pouvez créer une collection dans la Library et celle-ci peut 
être transférée vers le Reader. Pour plus de détails sur la création 
et le transfert d’une collection, reportez-vous à l’Aide eBook 
Library.

 Sélectionnez le contenu que vous souhaitez 
transférer depuis la liste.
Cliquez sur les fichiers tout en maintenant la touche Ctrl 
enfoncée pour sélectionner plusieurs fichiers à la fois.

 Faites glisser les fichiers depuis la liste vers 
« Sony’s Reader » dans l’affichage par source.
Les fichiers sont transférés vers le Reader.

Reader de Sony
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Conseil
• Vous pouvez stocker des données informatiques dans la mémoire 

flash intégrée de votre Reader en les transférant depuis votre 
ordinateur à l’aide de l’Explorateur Windows.

Remarques

• Si la mémoire de votre Reader est insuffisante, les fichiers risquent 
de ne pas pouvoir être transférés. Transférez l’ensemble du 
contenu inutile vers eBook Library, puis supprimez-le pour 
augmenter l’espace disponible du Reader. (  page 32)

• Ne supprimez pas le contenu des sous-dossiers ou les fichiers du 
dossier « database » à l’aide de l’Explorateur Windows. Gérez des 
données à l’aide de eBook Library. Pour plus d’informations sur 
l’utilisation de eBook Library, reportez-vous à l’Aide eBook Library.

Transfert de contenu via une carte mémoire

Les fichiers importés dans eBook Library peuvent être 
transférés vers une carte mémoire insérée dans le Reader.
Conseil
• Vous pouvez utiliser les cartes « Memory Stick Duo » ou les 

Cartes mémoire SD.

 Cliquez sur le menu Démarrer, puis sélectionnez  
« Tous les programmes » – « Reader » –  
« eBook Library » pour lancer eBook Library.

 Raccordez votre Reader à votre ordinateur à l’aide 
du câble USB fourni. (  page 28)
« Sony’s Reader » apparaît dans l’affichage par source 
de eBook Library.
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 Insérez une carte mémoire dans la fente pour carte 
mémoire du Reader. (  page 20)
« Memory Stick/SD Card on Sony’s Reader » apparaît 
dans l’affichage par source.

 Cliquez sur « Library » dans l’affichage par source, 
puis sur  (affichage par liste).
La zone d’affichage passe à l’affichage par liste et tout 
le contenu de la Library est répertorié.

	 Conseils
• Lorsque vous cliquez sur « Books », « Audio » ou « Pictures » 

dans l’affichage par source, seul le contenu correspondant 
s’affiche.

• Lorsque vous cliquez sur  (affichage par vignette), le contenu 
s’affiche sous forme de vignettes.

• Vous pouvez créer une collection dans la Library et celle-ci peut 
être transférée vers la carte mémoire du Reader. Pour plus de 
détails sur la création et le transfert d’une collection, reportez-
vous à l’Aide eBook Library.

 Sélectionnez le contenu que vous souhaitez 
transférer depuis la liste.
Cliquez sur les fichiers tout en maintenant la touche Ctrl 
enfoncée pour sélectionner plusieurs fichiers à la fois.

 Faites glisser les fichiers depuis la liste vers  
« Memory Stick/SD Card on Sony’s Reader » dans 
l’affichage par source.
Les fichiers sont transférés vers la carte mémoire du 
Reader.
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Conseil
• Vous pouvez stocker des données informatiques dans la carte 

mémoire insérée dans votre Reader en transférant ces données 
depuis votre ordinateur à l’aide de l’Explorateur Windows.

Remarques

• Si la carte mémoire ne contient pas assez d’espace disponible, les 
fichiers risquent de ne pas pouvoir être transférés. Transférez tout 
le contenu inutile vers eBook Library, puis supprimez-le pour 
augmenter l’espace libre de la carte mémoire. (  page 32)

• Ne supprimez pas le contenu des sous-dossiers ou les fichiers du 
dossier « Sony Reader » à l’aide de l’Explorateur Windows. La 
gestion des données s’effectue depuis eBook Library. Pour plus 
d’informations sur l’utilisation de eBook Library, reportez-vous à 
l’Aide eBook Library.

Pour transférer du contenu de l’appareil vers 
eBook Library

 Cliquez sur le menu Démarrer, puis sélectionnez  
« Tous les programmes » – « Reader » – « eBook 
Library » pour lancer eBook Library.

 Raccordez votre Reader à votre ordinateur à l’aide 
du câble USB fourni. (  page 28)
« Sony’s Reader » apparaît dans l’affichage par source.
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 Cliquez sur « Sony’s Reader » dans l’affichage par 
source, puis sur  (affichage par liste).
La zone d’affichage passe à l’affichage par liste et tout 
le contenu de la Library est répertorié.

 Conseils
• Lorsque vous cliquez sur « Books », « Audio » ou « Pictures » 

dans l’affichage par source, seul le contenu correspondant 
s’affiche.

• Lorsque vous cliquez sur  (affichage par vignette), le contenu 
s’affiche sous forme de vignettes.

• Vous pouvez créer une collection dans le Reader ou sur une 
carte mémoire du Reader, puis cette collection peut être 
transférée vers eBook Library. Pour plus de détails sur la création 
et le transfert d’une collection, reportez-vous à l’Aide eBook 
Library.

 Sélectionnez le contenu que vous souhaitez 
transférer depuis la liste.
Pour sélectionner plusieurs fichiers à la fois, cliquez tout 
en maintenant la touche Ctrl enfoncée.

 Faites glisser les fichiers depuis la liste vers  
« Library » dans l’affichage par source.
Le contenu de l’appareil est transféré vers eBook 
Library.
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Synchronisation du contenu de la Library 
avec le Reader

Vous pouvez synchroniser le contenu de votre eBook Library 
avec le Reader en sélectionnant un dossier (tel que  
« Library » ou ses sous-dossiers). Le Reader peut être mis à 
jour automatiquement pour correspondre au contenu de la 
Library, lors du raccordement à votre ordinateur.

Remarque

• Pour synchroniser le contenu de votre eBook Library avec le 
Reader, vous devez spécifier un dossier (tel que  
« Library » ou ses sous-dossiers). Pour plus de détails sur la 
sélection d’un dossier, reportez-vous à l’Aide eBook Library.

Conseil
• Si vous souhaitez synchroniser instantanément le contenu de la 

Library avec le Reader, vous pouvez aussi les synchroniser 
manuellement. Pour plus de détails sur la synchronisation manuelle 
du contenu, reportez-vous à l’Aide eBook Library.

 Cliquez sur le menu Démarrer, puis sélectionnez  
« Tous les programmes » – « Reader » – « eBook 
Library » pour lancer eBook Library.

 Raccordez le Reader à votre ordinateur à l’aide du 
câble USB fourni. (  page 28)
eBook Library commence automatiquement la synchronisation 
du contenu de la Library avec le Reader.

Conseil
• Si vous démarrez eBook Library après avoir raccordé le Reader à votre 

ordinateur, eBook Library commence aussi automatiquement la 
synchronisation du contenu de la Library avec le Reader.
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Lecture/Écoute/Visualisation d’un contenu

Lecture de livres
Lecture de livres transférés depuis votre 
ordinateur

Suivez les étapes ci-dessous pour lire des livres transférés 
depuis votre ordinateur.

 Dans le menu d’accueil, appuyez sur la touche / 
pour sélectionner « Books by Title », puis appuyez 
sur Entrée.
La liste de livres apparaît. 
Si le contenu du livre sur le Reader et la carte mémoire 
dépasse 30 éléments, le menu d’index apparaît. Vous 
pouvez trier davantage la liste de livres en sélectionnant 
un élément de catégorie dans le menu d’index.  
(  page 43)

Indique que le 
contenu est 
enregistré sur la 
carte mémoire.

 :  « Memory 
Stick Duo » 

 :  Carte 
mémoire SD

Boutons numérotés

Indicateur 
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	 Conseils
• Le contenu de la carte mémoire apparaît également dans la liste 

de livres.
• Outre les touches /, vous pouvez également sélectionner un 

élément en appuyant sur la touche numérique correspondant au 
bouton numéroté.

• Pour afficher le reste de la liste, appuyez sur > (de façon répétée).
• Vous pouvez passer directement à la dernière page affichée en 

sélectionnant « Continue Reading » dans le menu d’accueil, sans 
afficher la liste de livres. 

• Si une opération incorrecte est effectuée,  apparaît au bas de 
l’écran.

 Appuyez sur / pour sélectionner le livre de votre 
choix dans la liste, puis appuyez sur Entrée.
Le menu d’options apparaît. (  page 37)

 Appuyez sur / pour sélectionner la façon d’ouvrir 
le livre, puis appuyez sur Entrée.
Pour lire le livre depuis le début, appuyez sur / pour 
sélectionner « Begin », puis appuyez sur Entrée. 
La première page du livre apparaît. 

Pour ouvrir la table des matières du livre ou les signets 
du fichier PDF, appuyez sur / pour sélectionner  
« Table of Contents », puis appuyez sur Entrée. 
La table des matières ou les signets apparaissent (le 
cas échéant). 

Appuyez sur MENU pour fermer le livre.
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À propos du menu d’options
Le titre du livre est affiché.

Pour ouvrir la dernière page affichée.
Pour ouvrir la première page du livre.
Pour ouvrir la dernière page du livre.
Pour ouvrir la liste des signets. (  page 47)
Pour ouvrir la table des matières du 
livre ou les signets du fichier PDF, le 
cas échéant. 
Pour ouvrir la liste des pages 
précédemment affichées (  page 50)

Pour supprimer tous les signets ou effacer 
l’historique. (  pages 49, 50)

Pour afficher les informations relatives au livre. (  page 42)

Types de livre pris en charge par le Reader
Les types de livres pris en charge par le Reader et leurs 
caractéristiques sont décrits ci-dessous.

eBook 
(extension de 
fichier .lrf et .lrx)

Livre au format BBeB qui peut être 
téléchargé depuis CONNECT eBooks.
L’outil de liens intégré dans les eBooks 
(sauts de page, etc.) peut être utilisé.  
(  page 39)

Fichier PDF 
(extension de 
fichier .pdf)

Fichier au format PDF (Version 1.4 ou 
antérieure) Les signets et l’outil de liens 
peuvent être utilisés sur les fichiers PDF.

Fichier texte 
(extension de 
fichier .txt)
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Fichier RTF 
(extension de 
fichier .rtf)

Fichier RTF automatiquement converti 
depuis un fichier Microsoft Word.*
* Uniquement si Microsoft Word est installé 

sur votre ordinateur.

Opérations possibles sur la page d’un livre
Vous pouvez exécuter les opérations suivantes à partir de 
l’écran de la page du livre.

Indicateur de taille
Numéro de la page actuelle/
Nombre total de pages

Touche Opération

Touche > Permet de passer à la page suivante 
(appuyez) ; 
de sauter 10 pages à partir de la page actuelle 
(maintenez la touche enfoncée).

Touche < Permet de passer à la page précédente 
(appuyez) ; 
de reculer de 10 pages à partir de la page 
actuelle (maintenez la touche enfoncée).

Touches 
numériques

Permettent de passer à la page sélectionnée 
(appuyez) (  page 40) ;
de passer à la dernière page (maintenez la touche 
0 enfoncée) ; de passer à la première page 
(maintenez la touche 1 enfoncée) ; de passer à 
une page correspondant au(x) numéro(s) de la 
touche (maintenez les touches 2-9 enfoncées).
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Touche Opération

Touche 
 (taille)

Permet d’effectuer un zoom avant/arrière sur 
une page.  
À chaque pression sur la touche  (taille), la 
page est agrandie par incréments et revient à 
sa taille d’origine une fois l’agrandissement 
maximal atteint.
• Lors de la lecture d’un eBook ou d’un fichier texte : 

La taille change selon 3 incréments ( , ,  – 
indiquées au bas de l’écran).

• Lors de la lecture d’un fichier PDF : 
La taille varie entre « Fit width » (la page remplit la 
largeur de la fenêtre) et « Fit Visible » (le texte et les 
graphiques remplissent la largeur de la fenêtre).

• En maintenant la touche  (taille) enfoncée pendant 
quelques secondes, vous pouvez modifier l’orientation 
de l’écran (verticale/horizontale). (  page 41)

Touche 
 (MARQUE)

Permet de créer ou supprimer un signet sur la 
page actuelle (appuyez) (  pages 47, 49) ; 
de passer à l’écran All Bookmark (maintenez la 
touche enfoncée).

Touche MENU Permet de fermer la page et de revenir au menu d’options.

Pour utiliser l’outil de liens des eBooks/fichiers 
PDF sur le Reader
Lorsqu’un eBook ou un fichier PDF est affiché, vous pouvez 
utiliser l’outil de liens intégré. 
Le lien est mis en surbrillance à l’écran. Appuyez sur Entrée 
pour ouvrir le contenu du lien ou passer à la page liée.

Appuyez sur / pour sélectionner le 
lien de votre choix, puis appuyez sur 
/ pour revenir à la page 
précédemment affichée.

Lien
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Accès direct à la page indiquée

Vous pouvez accéder directement à une page en saisissant 
son numéro à l’aide des touches numériques.

 Dans l’écran de la page du livre, appuyez sur les 
touches numériques pour saisir le numéro de page.
Le numéro de page saisi apparaît au centre de la page.

Pour effacer le numéro de page saisi, appuyez sur .

 Appuyez sur Entrée. 
La page correspondant au numéro de page saisi 
apparaît.

Conseil
• Si vous appuyez sur la touche MENU, l’écran précédent apparaît. 

Vous pouvez saisir de nouveau le numéro de la page.
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Modification de l’orientation de l’écran 
(verticale/horizontale)

L’orientation de l’écran (y compris des écrans de menu) peut 
être modifiée des 2 façons suivantes.
• Maintenez la touche  (taille) enfoncée sur un écran de menu ou 

l’écran de la page du livre. 
Maintenez de nouveau la touche  (taille) enfoncée pour revenir 
au réglage précédent.

• Configurez ce paramètre à partir du menu de réglages. (  page 
58)

À propos de la division de l’écran lorsque 
l’orientation de l’écran est horizontale
Lorsque l’orientation est horizontale, une page de livre est 
divisée en 2 parties (inférieure et supérieure). Pour afficher 
la partie inférieure, appuyez sur >.

>

<

Affichage de la 
partie supérieure

Affichage de la 
partie inférieure

Indicateur de 
position
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Affichage des informations relatives au livre

Vous pouvez afficher des informations relatives à un livre, 
telles que le titre, l’auteur, la vignette de la couverture, etc.

 Dans le menu d’options, appuyez sur / pour 
sélectionner « Info », puis appuyez sur Entrée.
Les informations relatives au livre s’affichent.
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Classement de la liste de livres

Dans la liste des « Books by Title », les livres sont classés 
par titre, dans l’ordre alphabétique. Vous pouvez également 
classer les livres par auteur ou par date. Si le contenu du 
livre sur le Reader et la carte mémoire dépasse 30 
éléments, le menu d’index apparaît. Vous pouvez trier 
davantage la liste de livres en sélectionnant un élément de 
catégorie dans le menu d’index.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Books by Title », « Books by Author » 
ou « Books by Date », puis appuyez sur Entrée.
Le menu d’index apparaît. (  page 45)
Le menu d’index n’apparaît pas si le contenu du livre 
sur le Reader et la carte mémoire contient moins de 30 
éléments. Dans ce cas, appuyez sur < pour afficher le 
menu d’index.

 Conseil
• Si vous sélectionnez « Books by Date », les éléments de 

catégorie du menu d’index sont différents de ceux présentés ci-
dessus. (  page 45)
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 Appuyez sur / pour sélectionner la façon de trier 
la liste, puis appuyez sur Entrée.

 Appuyez sur / pour sélectionner le livre de votre 
choix dans la liste, puis appuyez sur Entrée.
Le menu d’options apparaît.

 Appuyez sur / pour sélectionner la façon d’ouvrir 
le livre, puis appuyez sur Entrée.

44 FR 



PRS-505.FR.3-277-508-01(2)

À propos du menu d’index

Menu d’index de « Books by 
Title » et « Books by Author »

Nombre de 
livres dans la 
catégorie et 
numéro de la 
page dans la 
liste de livres

Catégories

Menu d’index de « Books by 
Date »

Lors de la sélection de « Books by Title » et  
« Books by Author »
Vous pouvez sélectionner la première lettre du titre du livre ou du 
nom de l’auteur. Une liste de livres classée par ordre alphabétique et 
par titre ou auteur, commençant par la lettre sélectionnée, apparaît.

Lors de la sélection de « Books by Date »
Vous pouvez sélectionner la date de transfert vers le Reader et la 
carte mémoire. Une liste de livres triée par date de transfert apparaît.
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Sélection d’un livre dans la liste de 
collections

Vous pouvez sélectionner et lire un livre à partir de la liste 
de collections créée dans eBook Library.

Conseil
• Pour plus de détails sur la création et le transfert d’une collection, 

reportez-vous à l’Aide eBook Library.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Collections », puis appuyez sur 
Entrée.
La liste de collections apparaît.

 Appuyez sur / pour sélectionner la collection de 
votre choix dans la liste, puis appuyez sur Entrée.
La liste de livres apparaît.

 Sélectionnez le livre de votre choix dans la liste, 
puis appuyez sur Entrée.
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Création d’un signet sur une page

Vous pouvez créer un signet sur une page afin de l’atteindre 
facilement plus tard.

 Dans l’écran de la page du livre, appuyez sur la 
touche  (MARQUE) à la page souhaitée.
Le signet apparaît dans le coin supérieur droit de la 
page.

Signet

Si vous appuyez de nouveau sur la touche  
 (MARQUE), le signet est supprimé.

Remarque
• Lors de la création d’un signet, le Reader enregistre la page 

actuelle et sa taille. Par conséquent, même si, sur une page 
donnée, la taille est modifiée et un autre signet est créé, les 
signets seront enregistrés à leur taille respective.
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Pour ouvrir la page souhaitée à partir de la liste 
de signets

 Dans le menu d’options, appuyez sur / pour 
sélectionner « Bookmarks », puis appuyez sur 
Entrée.
La liste de signets apparaît.

 Appuyez sur / pour sélectionner la page de votre 
choix, puis appuyez sur Entrée.

Conseil
• Vous pouvez également créer des signets dans eBook Library.
 Les signets créés dans le Reader ou dans eBook Library sont 

conservés lorsque vous transférez des livres entre le Reader et 
eBook Library.

 Si vous transférez un livre du Reader vers eBook Library, les 
signets créés sur le Reader sont également transférés vers eBook 
Library, et vice versa. 
Toutefois, si vous transférez un livre vers un emplacement qui 
contient déjà le même livre, les signets ne sont pas écrasés.
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Pour supprimer tous les signets du livre actuel

 Dans le menu d’options, appuyez sur / pour 
sélectionner « Utilities », puis appuyez sur Entrée.

 Appuyez sur / pour sélectionner « Remove All 
Bookmarks », puis appuyez sur Entrée.
Tous les signets du livre actuel sont supprimés.
Remarque

• Faites attention avant de supprimer les signets.

Pour effectuer une sélection dans la liste de 
tous les signets du Reader

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « All Bookmarks », puis appuyez sur 
Entrée.
La liste de tous les signets du Reader apparaît.

 Appuyez sur / pour sélectionner la page de votre 
choix, puis appuyez sur Entrée.

Conseil
• Vous pouvez également afficher la liste de tous les signets en 

maintenant la touche  (MARQUE) enfoncée.
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Lecture des pages précédemment affichées

Le Reader enregistre toutes les pages affichées afin de 
pouvoir les rappeler facilement, à tout moment.

 Dans l’écran de la page du livre, appuyez sur .
Lorsque vous appuyez sur la touche  de façon 
répétée, les pages précédemment affichées 
apparaissent, de la plus récente à la plus ancienne.

Pour afficher l’historique de la page affichée

 Dans le menu d’options, appuyez sur / pour 
sélectionner « History », puis appuyez sur Entrée.
La liste de l’historique apparaît.

Conseil
• La liste de l’historique peut contenir l’historique d’une centaine de 

pages maximum.

Pour effacer l’historique

 Dans le menu d’options, appuyez sur / pour 
sélectionner « Utilities », puis appuyez sur Entrée.

 Appuyez sur / pour sélectionner « Clear  
History », puis appuyez sur Entrée.
Les données de l’historique du livre actuel sont effacées.
Remarque

• Faites attention avant de supprimer l’historique.
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Lecture de fichiers audio
Lecture de fichiers audio transférés depuis 
votre ordinateur

Les fichiers MP3 et AAC décryptés peuvent être lus sur le 
Reader.
Vous pouvez également lire des livres tout en écoutant un 
fichier audio. (  page 53)
Lors de l’écoute de fichiers audio, raccordez les écouteurs 
en options à la prise écouteurs.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Audio », puis appuyez sur Entrée.
La liste des fichiers audio apparaît.

Indique que le 
contenu est 
enregistré sur la 
carte mémoire.

 :  « Memory 
Stick Duo » 

 :  Carte 
mémoire SD

Vignettes des 
images (le cas 
échéant)

Boutons numérotés

Indicateur 
 Conseils

• Le contenu de la carte mémoire apparaît également dans la liste 
des fichiers audio.

• Outre les touches /, vous pouvez également sélectionner un 
élément en appuyant sur la touche numérique correspondant au 
bouton numéroté.

Suite 51 FR 



PRS-505.FR.3-277-508-01(2)

• Pour afficher le reste de la liste, appuyez sur > (de façon répétée).
• Si une opération incorrecte est effectuée,  apparaît au bas de l’écran.
• Lors de la lecture d’un fichier audio, « Now Playing » peut être 

sélectionné dans le menu d’accueil et l’écran de lecture peut être 
affiché.

• L’icône de lecture en cours dans le menu d’accueil change lors de 
la lecture d’un fichier audio.

 Appuyez sur / pour sélectionner la piste de votre 
choix dans la liste, puis appuyez sur Entrée.
La lecture commence.
Les pistes sont lues par ordre alphabétique. 

Pour interrompre la lecture, appuyez sur Entrée.

Opérations disponible sur l’écran de lecture
Vous pouvez exécuter les opérations suivantes à partir de 
l’écran de lecture.

Indicateur de lecture

Zone d’image

Nom de la piste
Nom de l’artiste
Nom de l’album

Temps de lecture 
écoulé

Indicateur de volume

Durée totale de 
la piste actuelle

Numéro de la piste 
actuelle/Nombre 
total de pistes

Barre d’état
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Touche Opération

Touche > Permet de passer à la piste suivante.
Touche < Permet de passer à la piste précédente.

/ Permet d’effectuer une avance/un retour 
rapide dans la piste.

Touche Entrée Permet d’interrompre/de reprendre la lecture de la piste.

Touches 
VOLUME +/–

Permettent de régler le volume.

Lecture de livres et d’un fichier audio simultanée

Vous pouvez lire des livres tout en écoutant un fichier audio.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Audio », puis appuyez sur Entrée.
La liste des fichiers audio apparaît.

 Appuyez sur la touche / pour sélectionner la piste 
de votre choix dans la liste, puis appuyez sur Entrée.
La lecture commence.

 Appuyez 2 fois sur la touche MENU pour revenir au 
menu d’accueil.

 Appuyez sur / pour sélectionner « Books by 
Title », puis appuyez sur Entrée.
La liste de livres apparaît.

 Appuyez sur / pour sélectionner le livre de votre 
choix dans la liste, puis appuyez sur Entrée.
Le menu d’options apparaît.
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 Appuyez sur / pour sélectionner la façon d’ouvrir 
le livre, puis appuyez sur Entrée.
L’écran de la page du livre apparaît.  
Lors de la lecture d’un fichier audio, l’indicateur de 
volume  s’affiche en bas de l’écran.

Conseil
• Pour interrompre la lecture, appuyez 3 fois sur la touche MENU 

pour revenir au menu d’accueil, sélectionnez « Now Playing » à 
l’aide des touches / et Entrée, puis appuyez sur Entrée dans 
l’écran de lecture.
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Visualisation d’images
Visualisation d’images transférées depuis votre 
ordinateur

Les fichiers BMP/JPEG/GIF/PNG peuvent être visualisés 
sur le Reader.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Pictures », puis appuyez sur Entrée.
La liste des images apparaît.

Indique que le 
contenu est 
enregistré sur la 
carte mémoire.

 :  « Memory 
Stick Duo » 

 :  Carte 
mémoire SD

Vignettes

Boutons numérotés

Indicateur 

	 Conseils
• Le contenu de la carte mémoire apparaît également dans la liste 

des images.
• Outre les touches /, vous pouvez également sélectionner un 

élément en appuyant sur la touche numérique correspondant au 
bouton numéroté.

• Pour afficher le reste de la liste, appuyez sur > (de façon répétée).
• Si une opération incorrecte est effectuée,  apparaît au bas de 

l’écran.
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 Appuyez sur / pour sélectionner l’image de votre 
choix dans la liste, puis appuyez sur Entrée.
L’image s’affiche.

Opérations disponibles sur l’écran de 
visualisation d’images
Vous pouvez exécuter les opérations suivantes à partir de 
l’écran de visualisation d’images.

Numéro de l’image actuelle/
Nombre total d’images

Indicateur de taille

Touche Opération

Touche > Permet d’afficher l’image suivante.

Touche < Permet d’afficher l’image précédente.

Touche 
 (taille)

Permet d’effectuer un zoom avant/arrière sur 
une page.  
À chaque pression sur la touche  (taille), 
l’image est agrandie par incréments et revient 
à sa taille d’origine une fois l’agrandissement 
maximal atteint.
La taille change selon 3 incréments ( , ,  
 – indiquées au bas de l’écran).

Touche Entrée Permet de restaurer la taille d’origine d’une 
image agrandie.
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Pour faire défiler une image agrandie
Si vous agrandissez l’image en appuyant sur la touche 

 (taille), / / /  s’affichent sur les côtés de l’écran.  
Appuyez sur /// pour faire défiler l’écran.

Pour visualiser des images en diaporama
Vous pouvez afficher un diaporama d’images.  
Activez le diaporama, puis sélectionnez l’image par laquelle 
vous souhaitez commencer dans la liste des images.
Vous pouvez configurer le diaporama dans le menu de 
réglages (  page 60).
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Paramètres

Réglage de l’orientation de l’écran
Vous pouvez régler l’orientation de l’écran (y compris les 
écrans de menu) à la verticale et/ou à l’horizontale.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Settings », puis appuyez sur Entrée.
Le menu de réglages apparaît.

 Appuyez sur / pour sélectionner « Orientation », 
puis appuyez sur Entrée.
L’orientation passe de la verticale à l’horizontale.
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Réglage de la date et de l’heure
Vous pouvez régler la date et l’heure affichées à l’écran du 
Reader.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Settings », puis appuyez sur Entrée.
Le menu de réglages apparaît.

 Appuyez sur / pour sélectionner « Date and Time », 
puis appuyez sur Entrée.

 Appuyez sur / pour sélectionner « Year », « Month », 
« Date », « Hour » et « Minute », puis appuyez sur les 
touches numériques pour saisir la date et l’heure.

 Appuyez sur / pour sélectionner « OK », puis 
appuyez sur Entrée.

Conseil
• Lorsque vous raccordez le Reader à votre ordinateur et que eBook 

Library est ouvert, la date et l’heure du Reader sont automatiquement 
synchronisées avec l’horloge de votre ordinateur.
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Réglage du diaporama
Suivez les étapes ci-dessous pour configurer les réglages 
du diaporama.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Settings », puis appuyez sur Entrée.
Le menu de réglages apparaît.

 Appuyez sur / pour sélectionner « Slideshow », 
puis appuyez sur Entrée.
L’écran de réglage du diaporama apparaît.

 Appuyez plusieurs fois sur Entrée pour sélectionner 
« Off » ou « On ».
La sélection passe de « Off » à « On » et le réglage du 
diaporama est activé.

 Appuyez sur // pour sélectionner « Slide 
Duration », puis appuyez sur les touches 
numériques pour saisir une durée.
Vous pouvez régler « Slide Duration » jusqu’à 
60 secondes, par incréments d’une 1 seconde.

 Appuyez sur /// pour sélectionner « OK », puis 
appuyez sur Entrée.

Remarques

• Le réglage du diaporama par défaut est « Off ».
• L’affichage d’une image volumineuse peut prendre plus de temps 

que la durée réglée dans « Slide Duration ».
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Réglage du mode de veille 
(fonction de reprise)
Vous pouvez configurer le Reader pour qu’il passe 
automatiquement en mode de veille. En mode de veille, le 
Reader se met automatiquement hors tension lorsqu’il reste 
inutilisé pendant 60 minutes (fonction de reprise).

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Settings », puis appuyez sur Entrée.
Le menu de réglages apparaît.

 Appuyez sur / pour sélectionner « Sleep Mode », 
puis appuyez sur Entrée.
L’écran de réglage du mode de veille apparaît.

 Appuyez plusieurs fois sur Entrée pour sélectionner 
« Off » ou « On ».
Off : le Reader ne passe jamais en mode de veille. 
On : le Reader passe automatiquement en mode de 
veille.

 Appuyez sur / pour sélectionner « OK », puis 
appuyez sur Entrée.
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Remarques

• Le réglage du mode de veille par défaut est « On ».
• Dans les cas suivants, le Reader ne se met pas automatiquement 

hors tension lorsqu’il reste inutilisé pendant 60 minutes.
– Lors du raccordement à l’ordinateur à l’aide du câble USB fourni
– Lorsqu’il est raccordé à l’adaptateur CA pour le Reader 

AC-S5220E (en option) pour la charge
– Lors de la lecture de fichiers audio

Conseil
• Pour réduire la consommation d’énergie, le Reader propose les 

deux modes suivants :
– Mode de veille :
 Le Reader peut être configuré pour passer automatiquement en 

mode de veille après une période d’inactivité. Une fois en mode 
de veille, le Reader passe en mode d’économie d’énergie et 
empêche toute saisie involontaire via le pavé numérique. Pour 
remettre le Reader sous tension, faites glisser le commutateur 
POWER. L’écran précédemment affiché apparaît immédiatement 
sur le Reader.

– Mode « Device Shutdown » :
 Le Reader peut être configuré pour passer en mode « Device 

Shutdown ». Une fois en mode « Device Shutdown », le Reader 
ne consomme plus d’énergie, ce qui permet de prolonger 
l’autonomie de la batterie. Pour remettre le Reader sous tension, 
faites glisser le commutateur POWER. L’écran de démarrage 
apparaît après quelques instants. (  page 66)
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Réglages avancés
Vous pouvez verrouiller le Reader, formater la mémoire 
flash intégrée et arrêter le Reader.

Verrouillage du Reader

Vous pouvez verrouiller l’écran du Reader en configurant un 
mot de passe.
Suivez les étapes ci-dessous.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Settings », puis appuyez sur Entrée.
Le menu de réglages apparaît.

 Appuyez sur / pour sélectionner « Advanced 
Settings », puis appuyez sur Entrée.
Le menu de réglages avancés apparaît.

 Appuyez sur / pour sélectionner « Device Lock », 
puis appuyez sur Entrée.
L’écran de réglage du verrouillage de l’appareil apparaît.

 Appuyez plusieurs fois sur Entrée pour sélectionner 
« Off » ou « On ».
La sélection passe de « Off » à « On » et le réglage du 
verrouillage de l’appareil est activé.

Remarque

• Si le verrouillage de l’appareil est activé, le Reader n’est pas reconnu 
par votre ordinateur, et le transfert de son contenu est impossible. 
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 Appuyez sur // pour sélectionner « Code », puis 
appuyez sur les touches numériques pour saisir le 
mot de passe.
Le mot de passe à 4 chiffres est configuré.

 Appuyez sur /// pour sélectionner « OK », puis 
appuyez sur Entrée.

Après configuration du mot de passe, un écran de saisie du mot 
de passe apparaît dès la mise sous tension du Reader. 
Appuyez sur les touches numériques pour saisir le mot de 
passe, appuyez sur  pour sélectionner « OK », puis 
appuyez sur Entrée. 

Remarque

• Veillez à ne pas oublier ce mot de passe.
 Si vous perdez votre mot de passe, contactez l’assistance Sony au 

1-(866)-962-7669.
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Formatage de la mémoire interne

Vous pouvez formater la mémoire flash intégrée du Reader. 
Lors du formatage de la mémoire, tout le contenu est effacé.

Remarque

• Vérifiez le contenu de la mémoire avant le formatage et transférez 
les informations importantes sur le disque dur de votre ordinateur 
ou tout autre périphérique.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Settings », puis appuyez sur Entrée.
Le menu de réglages apparaît.

 Appuyez sur / pour sélectionner « Advanced 
Settings », puis appuyez sur Entrée.
Le menu de réglages avancés apparaît.

 Appuyez sur / pour sélectionner « Format 
Internal Memory », puis appuyez sur Entrée.

 Appuyez sur  (MARQUE) pour formater la mémoire 
flash intégrée du Reader.
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Arrêt du Reader

Si vous prévoyez de ne pas utiliser le Reader pendant 
plusieurs jours, vous pouvez réduire la consommation 
d’énergie de la batterie en arrêtant le Reader.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Settings », puis appuyez sur Entrée.
Le menu de réglages apparaît.

 Appuyez sur / pour sélectionner « Advanced 
Settings », puis appuyez sur Entrée.
Le menu de réglages avancés apparaît.

 Appuyez sur / pour sélectionner « Device 
Shutdown », puis appuyez sur Entrée.

 Appuyez sur  (MARQUE) pour arrêter le Reader.

Remarques

• Lorsque le Reader est arrêté et que vous le mettez sous tension 
en faisant glisser le commutateur POWER, la mise sous tension 
peut prendre quelques instants.

• Lorsque vous raccordez le Reader à votre ordinateur après l’avoir 
mis hors tension, il est nécessaire de le mettre de nouveau sous 
tension. Sinon, l’indication  (connexion USB) peut mettre 
environ 40 minutes à s’afficher. Vous ne pourrez pas mettre le 
Reader sous tension à l’aide du commutateur POWER pendant ce 
temps. Un témoin rouge s’allume lors du chargement du Reader si 
l’indication  ne s’affiche pas à l’écran. Dans ce cas, 
débranchez le câble USB du Reader, puis allumez le Reader et 
reconnectez-le.
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Vérification des informations 
relatives à la version du Reader
Le nom du produit et la version du micrologiciel du Reader 
peuvent être affichés.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Settings », puis appuyez sur Entrée.
Le menu de réglages apparaît.

 Appuyez sur / pour sélectionner « About », puis 
appuyez sur Entrée.
L’écran d’informations apparaît.
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Dépannage

Dépannage
Si votre Reader ne fonctionne pas correctement, respectez 
les étapes suivantes pour résoudre le problème.

 Réinitialisez le Reader en appuyant sur la touche 
Reset à l’aide d’un objet pointu.
Le contenu et les paramètres enregistrés dans le Reader 
ne sont pas affectés par la réinitialisation et aucune 
information n’est effacée.  
Après avoir appuyé sur la touche Reset, mettez le 
Reader sous tension en faisant glisser le commutateur 
POWER.

Remarque
• Lorsque vous raccordez le Reader à votre ordinateur après une 

réinitialisation, il est nécessaire de le mettre de nouveau sous 
tension. Sinon, l’indication  (connexion USB) peut mettre 
environ 40 minutes à s’afficher. Vous ne pourrez pas mettre le 
Reader sous tension à l’aide du commutateur POWER pendant 
ce temps. Un témoin rouge s’allume lors du chargement du 
Reader si l’indication  ne s’affiche pas à l’écran. Dans ce 
cas, débranchez le câble USB du Reader, puis allumez le Reader 
et reconnectez-le.

 Vérifiez les symptômes à la section « Dépannage ».
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 Consultez les informations relatives à ce problème 
dans l’Aide eBook Library.

 Consultez les informations relatives à ce problème 
sur l’un des sites Web de support à la clientèle.
http://www.sony.com/readersupport

 Si les conseils donnés ci-dessus ne permettent pas 
de résoudre le problème, contactez l’assistance 
Sony au 1-(866)-962-7669.

Alimentation
Symptôme Cause ou action corrective

L’autonomie de la 
batterie est faible.

 La température de fonctionnement 
est inférieure à 5 °C (41 °F). Ceci est 
dû à des caractéristiques propres à 
la batterie. Il ne s’agit pas d’un 
problème de fonctionnement.

 Vous n’avez pas utilisé le Reader 
pendant une période prolongée. 
L’efficacité de la batterie augmente 
au fil des charges et des décharges.

 La batterie doit être remplacée. 
Consultez votre centre de réparation 
Sony le plus proche.

 La batterie n’a pas eu le temps de se 
recharger complètement.

	 Chargez la batterie jusqu’à ce que le 
témoin s’éteigne. (L’icône de la 
batterie n’indique pas l’autonomie 
restante en cours de charge.)
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Symptôme Cause ou action corrective

Impossible de mettre 
le Reader sous 
tension.

 De la condensation s’est peut être 
formée. Attendez quelques heures, 
puis mettez de nouveau le Reader 
sous tension.

 Si la batterie est épuisée, raccordez le lecteur 
à votre ordinateur à l’aide d’un câble USB et 
chargez la batterie (  page 17).  
Si la batterie est complètement épuisée, 
l’indication  (connexion USB) peut mettre 
environ 40 minutes à s’afficher. Vous ne 
pourrez pas mettre le Reader sous tension à 
l’aide du commutateur POWER pendant ce 
temps. Dans ce cas, attendez que l’indication 

 s’affiche. Un témoin rouge s’allume lors 
du chargement du Reader si l’indication  
ne s’affiche pas à l’écran.

Écran
Symptôme Cause ou action corrective

L’affichage met 
quelque temps à 
apparaître.

 Dans un endroit froid, à l’extérieur 
par exemple, l’affichage peut mettre 
quelques instants à apparaître.

	 Ceci est dû à des caractéristiques 
propres à l’affichage. Il ne s’agit pas 
d’un problème de fonctionnement.

Autorisation/
désautorisation du 
Reader impossible 
avec CONNECT 
eBooks.

 L’autorisation ou la désautorisation 
du Reader est impossible avec 
CONNECT eBooks si l’option  
« Device Lock » du Reader est 
réglée à « On ». Réglez-la à  
« Off », puis autorisez ou 
désautorisez le Reader.

Suite

Alimentation (suite)
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Lecture/Écoute/Visualisation d’un contenu
Symptôme Cause ou action corrective

Impossible de lire un 
livre.

 Il est impossible de lire un livre 
protégé par des droits d’auteur sur 
un appareil autre que celui autorisé.

Impossible de lire un 
fichier audio.

 Les fichiers audio non pris en charge 
par le Reader ne peuvent pas être 
lus. Pour plus d’informations sur les 
fichiers audio pris en charge, voir  
page 51.

Aucun son n’est 
émis.

 Augmentez le volume s’il est faible.

 Si aucun son n’est émis via les 
écouteurs, vérifiez si la fiche des 
écouteurs est correctement insérée 
dans la prise écouteurs.

Impossible d’afficher 
une image.

 Les fichiers image non pris en charge 
par le Reader ne peuvent pas être 
visualisés. Pour plus d’informations 
sur les fichiers image pris en charge, 
voir  page 55.

 Si l’image est volumineuse, il est possible qu’elle 
ne puisse pas être affichée et que son fichier 
n’apparaisse pas dans la liste. Supprimez le 
fichier image à l’aide de eBook Library.

Les données de 
lecture continue, de 
signets ou 
d’historique de 
certains fichiers 
manquent.

 Si l’état du fichier a changé (comme dans 
les cas suivants), les données de lecture 
continue, de signets ou d’historique 
peuvent avoir été supprimées.
• Un fichier Texte/RTF/PDF est modifié.
• Un eBook acheté avec un Reader 

autorisé est lu sur un autre Reader 
désautorisé après un transfert de carte 
mémoire.
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Raccordement à l’ordinateur
Symptôme Cause ou action corrective

Impossible de faire 
fonctionner le 
Reader lors d’une 
connexion USB.

 Il est impossible de faire fonctionner 
le Reader lorsqu’il est raccordé à un 
ordinateur.

Le Reader n’est pas 
reconnu.

 Le Reader est-il sous tension ? Le 
câble USB est-il raccordé 
correctement ?

	 Vérifiez les éléments ci-dessus et 
essayez de nouveau.

 Utilisez-vous un concentrateur USB 
ou une rallonge USB ?

	 Le raccordement du Reader via un 
concentrateur ou une rallonge USB 
n’est pas pris en charge et risque de 
ne pas fonctionner. Raccordez le 
câble USB directement à l’ordinateur.

 Vérifiez si  (connexion USB) est 
affiché en haut de l’écran du Reader. 
Si le Reader n’est toujours pas 
reconnu, débranchez le câble USB 
du Reader, puis reconnectez-le 
après quelques instants.

 Si l’option « Device Lock » du 
Reader est réglée à « On », réglez-la 
à « Off ». Si le Reader est verrouillé, 
il ne sera pas reconnu par votre 
ordinateur.
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Symptôme Cause ou action corrective

Impossible de 
transférer du 
contenu du Reader 
vers l’ordinateur.

 Le câble USB n’est pas raccordé 
correctement. Débranchez le câble 
USB, puis reconnectez-le.

 La mémoire du Reader ne contient 
pas assez d’espace disponible. 
Transférez l’ensemble du contenu 
inutile vers eBook Library, puis 
supprimez-le pour augmenter 
l’espace disponible du Reader.

Aucune réponse de 
eBook Library lors 
d’une 
communication avec 
le Reader.

 Débranchez le câble USB du 
Reader, puis reconnectez-le.

Le Reader devient 
instable lorsqu’il est 
raccordé à un 
ordinateur.

 Utilisez-vous un concentrateur USB 
ou une rallonge USB ?

	 Le raccordement du Reader via un 
concentrateur ou une rallonge USB 
n’est pas pris en charge et risque de 
ne pas fonctionner. Raccordez le 
câble USB directement à l’ordinateur.

La batterie du 
Reader ne se charge 
pas. (Le témoin ne 
s’allume pas.)

 Le câble USB est-il raccordé 
correctement ? Vérifiez et essayez 
de nouveau.

 Utilisez-vous un concentrateur USB 
ou une rallonge USB ? Le 
raccordement du Reader via un 
concentrateur ou une rallonge USB 
n’est pas pris en charge et risque de 
ne pas fonctionner. Raccordez le 
câble USB directement à l’ordinateur.

Raccordement à l’ordinateur (suite)
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eBook
Symptôme Cause ou action corrective

Impossible de lire un 
eBook.

 Vous n’êtes pas identifié ou 
autorisé sur le service, ce qui est 
essentiel pour lire des eBooks. 
Autorisez votre ordinateur et le 
Reader.

 Vous avez essayé de lire du 
contenu appartenant à un autre 
utilisateur. Il est impossible de lire 
du contenu appartenant à un autre 
utilisateur.

 Les données d’autorisation sont 
endommagées en raison d’un arrêt 
en cours de lecture d’un eBook. 
Désautorisez votre ordinateur et le 
Reader, puis autorisez-les de 
nouveau.
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Carte mémoire
Symptôme Cause ou action corrective

Impossible de lire/
écouter/visualiser le 
contenu d’une carte 
mémoire.

 Vérifiez si la carte mémoire est 
insérée dans le bon sens dans la 
fente pour carte mémoire.

 Vérifiez que vous utilisez bien une 
carte mémoire prise en charge par le 
Reader.

 Nettoyez la zone de contact de la 
carte mémoire avec un chiffon doux, 
si nécessaire.

Impossible de 
transférer le contenu 
vers une carte 
mémoire.

 Débloquez l’onglet de protection en 
écriture s’il est verrouillé.

 La carte mémoire ne contient pas 
assez d’espace disponible. 
Supprimez les données inutiles.

Une carte mémoire 
n’est pas reconnue.

 Il est possible qu’une carte mémoire 
qui n’est pas formatée au format FAT 
ne soit pas reconnue sur eBook 
Library.

	 Lors du formatage d’une carte 
mémoire, formatez-la à l’aide de 
l’utilitaire de formatage fourni avec la 
carte mémoire ou à l’aide de 
l’Explorateur Windows, en précisant 
bien le format FAT.
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Restauration des paramètres par défaut

Tous les paramètres par défaut du Reader peuvent être 
restaurés.

Remarques

Les changements suivants se produisent lors de la restauration des 
paramètres par défaut.
• L’orientation de l’écran est verticale.
• Le mot de passe est effacé et le verrouillage de l’appareil 

désactivé.
• Le réglage du diaporama est réglé à « Off » et sa durée définie à 

5 secondes.
• Le volume est restauré au niveau par défaut.

 Dans le menu d’accueil, appuyez sur / pour 
sélectionner « Settings », puis appuyez sur Entrée.
Le menu de réglages apparaît.

 Appuyez sur / pour sélectionner « Restore 
Defaults », puis appuyez sur Entrée.
L’écran de restauration des paramètres par défaut 
apparaît. 
Si « Device Lock » (  page 63) est réglé à « On », 
l’écran de saisie du mot de passe apparaît. Saisissez le 
mot de passe, puis sélectionnez « OK ».

 Appuyez sur  (MARQUE) pour restaurer les 
paramètres par défaut.
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Désinstallation de eBook Library
Pour désinstaller le logiciel fourni de votre ordinateur, suivez 
la procédure ci-dessous.
Remarque

• Avant la désinstallation, désautorisez votre ordinateur, le cas échéant.
 Pour plus d’informations sur la désautorisation, reportez-vous à 

l’Aide eBook Library.

 Cliquez sur « Démarrer » – « Panneau de configuration ».

 Double-cliquez sur « Ajout/Suppression de programmes ». *1

 Cliquez sur « eBook Library by Sony » dans la liste 
« Programmes actuellement installés », puis cliquez 
sur « Supprimer ». *2

Suivez les instructions affichées à l’écran et redémarrez 
votre ordinateur. La désinstallation est terminée une fois 
l’ordinateur redémarré.

Désinstallation du Guide de l’utilisateur  
PRS-505
1 Cliquez sur « Démarrer » – « Panneau de configuration ».

2 Double-cliquez sur « Ajout/Suppression de programmes ». *1

3 Cliquez sur « PRS-505 User’s Guide » dans la liste  
« Programmes actuellement installés », puis cliquez sur  
« Supprimer ». *2

Suivez les instructions affichées à l’écran et redémarrez votre 
ordinateur. La désinstallation est terminée une fois l’ordinateur 
redémarré.

*1 « Désinstaller un programme » ou « Programmes et Fonctions » 
sous Windows Vista.

*2 « Désinstaller » sous Windows Vista.
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Informations complémentaires

Mise à jour du micrologiciel du 
Reader
Vous pouvez disposer des nouvelles fonctions disponibles 
en installant la dernière version du micrologiciel du Reader. 
Les mises à jour du micrologiciel peuvent être effectuées à 
partir du menu de mise à jour de eBook Library, accessible 
en cliquant sur « Help » – « Check for Updates ».
Pour plus d’informations sur les mises à jour, reportez-vous 
à l’Aide eBook Library ou visitez le site Web suivant : 
http://www.sony.com/readersupport
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À propos des livres pré-installés 
sur le Reader
Lorsque vous achetez votre Reader, il dispose déjà de 
certains échantillons de données qui vous permettent de 
l’essayer immédiatement. Les échantillons de données 
préinstallés permettent de tester la lecture, la visualisation 
et l’écoute.
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Remarques sur la mise au rebut 
du Reader
La batterie rechargeable intégrée du Reader est recyclable. 
Ne retirez pas la batterie vous-même, consultez le « Sony 
Portable Reader System Support Center » (  page 82).
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Précautions

Fiche d’identification
Les numéros de modèle et de série sont indiqués à l’arrière 
de l’appareil. Inscrivez ces numéros dans l’espace ci-
dessous. Faites-y référence chaque fois que vous appelez 
votre détaillant Sony au sujet de ce produit. 
N° de modèle __________________________
N° de série ____________________________
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Si vous avez des questions relatives à ce 
produit, contactez-nous :
Par Internet :
www.sony.com/readersupport
Par téléphone :
Sony Portable Reader System Support Center au 1-(866)-
962-7669
Par courrier :
Sony Customer Information Services Center
12451 Gateway Blvd., Fort Myers, FL 33913

Déclaration de conformité

Appellation commerciale : SONY 
N° de modèle : PRS-505
Partie responsable : Sony Electronics Inc.
Adresse :  16530 Via Esprillo,  

San Diego,  
CA 92127 U.S.A.

 Numéro de téléphone : 858-942-2230

Cet appareil est conforme à la section 15 des 
règlements de la FCC. Son fonctionnement est 
soumis aux deux conditions suivantes : (1) cet 
appareil ne doit pas provoquer d’interférences 
gênantes, et (2) cet appareil doit pouvoir 
accepter les interférences reçues, y compris les 
interférences risquant de déclencher des 
opérations non désirées.
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À l’attention des clients résidant aux États-
Unis et au Canada
RECYCLAGE DES ACCUMULATEURS AUXIONS 
DE LITHIUM
Les accumulateurs aux ions de lithium sont 
recyclables.
Vous pouvez contribuer à préserver 
l’environnement en rapportant les piles usées dans 
un point de collection et recyclage le plus proche.

Pour plus d’informations sur le recyclage des accumulateurs, 
téléphonez le numéro gratuit 1-800-822-8837 (Etats-Unis et 
Canada uniquement), ou visitez http://www.rbrc.org/

Avertissement : Ne pas utiliser des accumulateurs aux 
ions de lithium qui sont endommagées ou qui fuient.

Sécurité

• N’insérez aucun corps étranger dans la prise DC IN du 
Reader.

• Veillez à ne pas court-circuiter les bornes du Reader avec 
des objets métalliques.

Installation

• N’exposez jamais le Reader à de la lumière, à des 
températures, à de l’humidité ou des vibrations excessives.

• Ne recouvrez jamais le Reader en cours d’utilisation avec 
l’adaptateur CA. Une surchauffe interne du Reader risque 
de provoquer un problème de fonctionnement ou des 
dommages.
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Surchauffe interne

Une surchauffe interne risque de se produire lors du 
chargement du Reader ou s’il est utilisé pendant une 
période prolongée.

Écouteurs

Sécurité routière
N’utilisez pas les écouteurs lorsque vous conduisez une 
voiture, un vélo ou tout autre véhicule motorisé. Ceci est 
dangereux et illégal dans de nombreux pays. La lecture à un 
volume élevé peut également être dangereuse lors de 
déplacements à pieds, notamment au niveau des passages 
piéton. Utilisez l’appareil avec précaution ou interrompez 
son utilisation dans des situations potentiellement 
dangereuses.

Prévention des troubles auditifs
Évitez d’utiliser les écouteurs à un volume sonore élevé. Les 
médecins déconseillent l’écoute prolongée à un volume 
élevé. Si vous percevez un sifflement dans les oreilles, 
réduisez le volume ou interrompez l’écoute.

Respect d’autrui
Maintenez le volume à un niveau modéré. Ceci vous 
permettra d’entendre les sons extérieurs et d’être attentif à 
votre entourage.

Avertissement
Si un orage survient lorsque vous utilisez le Reader, retirez 
immédiatement les écouteurs.
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À propos des cartes mémoire

À propos des « Memory Stick Duo »
Un « Memory Stick Duo » est un support d’enregistrement à 
circuit imprimé compact, haute capacité. Vous pouvez 
échanger des données entre des appareils compatibles  
« Memory Stick Duo », mais vous pouvez également 
l’utiliser comme support de stockage amovible.

À propos des cartes mémoires SD
Les cartes mémoire SD sont conformes à la norme sur les 
cartes mémoire compactes et sont utilisées comme support 
de stockage pour les appareils photo numériques.

Pour plus d’informations sur les cartes mémoires prises en 
charge par le Reader, reportez-vous à la section « Insertion 
d’une carte mémoire » à la  page 19.

Remarques sur l’utilisation des cartes 
mémoire
• Lors de l’utilisation d’une carte miniSD sur le Reader, un 

adaptateur (vendu séparément) est requis.
• Le Reader n’est pas conforme avec :

− La norme MagicGate.
− La protection des droits d’auteur des cartes mémoire SD.
− Le transfert haut débit des cartes mémoire SD.
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• Vous ne pouvez pas enregistrer ou supprimer des 
données stockées sur une carte mémoire lorsque l’onglet 
de protection en écriture est verrouillé.

 

• Conservez les cartes mémoire dans leur étui pour les 
transporter ou les stocker.

• Ne touchez pas le connecteur d’une carte mémoire avec 
les doigts ou des objets métalliques.

• Ne pliez pas, n’échappez pas la carte mémoire ou ne 
l’exposez pas à des chocs excessifs.

• Ne démontez pas ou ne modifiez pas la carte mémoire.
• Ne mouillez pas la carte mémoire.
• Évitez d’effectuer les actions suivantes pour ne pas 

endommager les données. Sony n’offre aucune garantie 
pour les données endommagées.
− Retrait d’une carte mémoire ou mise hors tension du Reader 

pendant l’écriture ou la lecture de données.
− Utilisation du Reader dans des endroits où il peut être soumis à 

de l’électricité statique ou à des interférences électriques.

• N’utilisez pas d’autre étiquette que l’étiquette appropriée 
dans la zone mémo.

• N’utilisez pas ou ne conservez pas le Reader dans un 
endroit sujet :
− à des températures extrêmes, comme dans une voiture en plein soleil.
− à la lumière directe du soleil.
− à un fort taux d’humidité ou à des substances corrosives.
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Logiciels
• La législation sur les droits d’auteur interdit la reproduction 

partielle ou totale du logiciel ou du manuel qui 
l’accompagne, de même que le prêt du logiciel sans 
l’autorisation du détenteur des droits d’auteur.

• En aucun cas SONY ne pourra être tenu responsable de 
dommages financiers ou de pertes de profit, y compris les plaintes 
de tiers, résultant de l’utilisation du logiciel fourni avec le Reader.

• En cas de problème avec ce logiciel résultant d’une 
fabrication défectueuse, SONY le remplacera. SONY 
n’assume toutefois aucune autre responsabilité.

• Le logiciel fourni avec le Reader ne peut être utilisé avec 
aucun autre équipement que celui prévu à cet effet.

• Notez que, en raison d’efforts permanents visant à améliorer 
la qualité, les caractéristiques techniques du logiciel peuvent 
être modifiées sans préavis.

• L’utilisation du Reader avec un autre logiciel que celui 
fourni n’est pas couvert par la garantie.

• La possibilité d’afficher les langues dans votre eBook 
Library dépend du système d’exploitation installé sur votre 
ordinateur. Pour de meilleurs résultats, veuillez vous 
assurer que le système d’exploitation installé est 
compatible avec la langue que vous souhaitez afficher.
− Nous ne garantissons pas que toutes les langues seront 

affichées correctement sur votre eBook Library.
− Les caractères créés par l’utilisateur et certains caractères 

spéciaux risquent de ne pas s’afficher.
• Pour tirer le meilleur parti des explications données dans ce 

manuel, vous devez être familiarisé avec les fonctions de base 
de Windows. Pour obtenir davantage de détails sur l’utilisation de 
votre ordinateur et de son système d’exploitation, veuillez vous 
reporter aux manuels correspondants.
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Entretien
• Nettoyez le boîtier du Reader avec un chiffon doux, 

comme des lingettes nettoyantes pour lunettes.
• Si le boîtier du Reader est vraiment sale, nettoyez-le avec 

un chiffon doux légèrement imprégné d’eau ou d’une 
solution détergente neutre.

• N’utilisez pas de tampon abrasif, de poudre à récurer ni de 
solvant, tel que de l’alcool ou du benzène, qui risquent de 
ternir la surface du boîtier.

• Veillez à ne pas laisser d’eau pénétrer dans le Reader par 
l’orifice situé près du connecteur.

• Nettoyez régulièrement la fiche des écouteurs.

Si vous avez des questions ou des problèmes concernant le 
Reader, consultez votre revendeur Sony le plus proche.

Remarques

• Le contenu enregistré est limité à un usage privé exclusivement. 
L’utilisation du contenu au-delà de cette limite nécessite 
l’autorisation des détenteurs des droits d’auteur.

• Sony ne peut être tenu responsable de tout enregistrement ou 
téléchargement incorrect ou de dommages causés aux données 
suite à des problèmes rencontrés par le Reader ou l’ordinateur.
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À propos des droits d’auteur

Le contenu de chaque livre préinstallé sur ce produit est 
protégé par des droits d’auteur, et est édité avec la 
coopération de l’éditeur et du rédacteur mentionnés.
La législation sur les droits d’auteur interdit la 
reproduction, partielle ou totale, des données concernant 
ce produit ou du contenu de ce manuel (illustrations, 
documents liés, etc.) sans la permission du détenteur des 
droits d’auteur. En outre, l’utilisation des données 
concernant ce produit ou du contenu du présent manuel 
est interdite sans la permission de Sony, excepté pour un 
usage personnel.

• SONY et le logo SONY sont des marques déposées de Sony 
Corporation.

• BBeB, BBeB Book et leurs logos sont des marques de 
commerce de Sony Corporation.

• « Memory Stick », « Memory Stick Duo », « Memory Stick PRO 
Duo », et leurs logos sont des marques de commerce de Sony 
Corporation.

• Bitstream est une marque déposée et Dutch, Font Fusion et 
Swiss sont des marques de commerce de Bitstream Inc.

• Microsoft, Windows, Windows Vista et Windows Media sont des 
marques de commerce ou des marques déposées de Microsoft 
Corporation aux États-Unis et/ou dans d’autres pays.

• Adobe, Adobe Reader et Adobe PDF sont des marques de 
commerce ou des marques déposées de Adobe Systems 
Incorporated aux États-Unis et/ou dans d’autres pays.

• Licence de la technologie de codage audio MPEG Layer-3 et 
des brevets obtenue de Fraunhofer IIS et Thomson.
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• Ce produit utilise MontaVista Software, Inc.’s MontaVista(R) 
Linux(R) Professional Edition comme système d’exploitation. 
COPYRIGHT ©1999-2006 MONTAVISTA 
SOFTWARE, INC. TOUS DROITS 
RÉSERVÉS. 
http://www.mvista.com/

• MontaVista est une marque déposée de MontaVista Software, Inc.
• Ce produit inclut un logiciel développé par OpenSSL Project 

destiné à l’utilisation dans OpenSSL Toolkit.   
(<http://www.openssl.org/>)  Copyright © 1998-2006 The 
OpenSSL Project. Tous droits réservés. Ce produit comprend un 
logiciel cryptographique développé par Eric Young (eay@
cryptsoft.com). Ce produit contient un logiciel développé par 
Tim Hudson (tjh@cryptsoft.com). Pour obtenir plus de détails 
sur la licence OpenSSL, reportez-vous au document « openssl.
txt » sur le CD-ROM.

Tous les autres noms de système et de produit cités dans ce 
document sont en général des marques de commerce ou des 
marques déposées de leur détenteur respectif. Les symboles TM 
et ® n’apparaissent pas dans ce manuel.

Programme ©2006, 2007 Sony Corporation
Documentation ©2006, 2007 Sony Corporation

À propos de la LICENCE PUBLIQUE GÉNÉRALE GNU

Chers clients
Nous vous remercions d’avoir fait l’acquisition de ce produit. 
Ce produit contient le logiciel suivant, qui est applicable à la 
GPL/LGPL. Vous pouvez obtenir, modifier et redistribuer les 
codes source du logiciel.

bash
fileutils
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findutils
gcc
glib
glibc
grep
hardhatutils
hostname
mkcramfs
mtd-utils
mtools
ncurses
pam
procps
psmisc
sed
shellutils
sysutils
sysvinit
tar
textutils
time
util-linux

Ces codes source sont disponible depuis le site Web. Visitez 
le site Web suivant pour procéder au téléchargement.  
http://www.sony.net/Products/Linux/
Veuillez noter que Sony ne répond à aucune demande 
concernant le contenu de ces codes source.

Pour obtenir davantage d’informations sur la LICENCE 
PUBLIQUE GÉNÉRALE GNU, reportez-vous aux fichiers  
« gpl.txt » et « lgpl.txt » sur le CD-ROM.
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Caractéristiques techniques

Nom de modèle
PRS-505

Source d’alimentation
Batterie rechargeable intégrée : 3,7 V CC
Adaptateur secteur : 5,2 V CC

Autonomie de la batterie (lecture en continu)
Environ 7 500 pages (lorsque la batterie est entièrement chargée)

Capacité utilisateur disponible
Environ 192 Mo. 
La capacité de stockage disponible du Reader peut varier.

Température de fonctionnement
5 à 35 °C (41 to 95 °F)

Dimensions (l/h/p)
Environ 6,9 x 4,8 x 0,3 pouces 
(maximum, sans étui souple)

Poids
Environ 9 oz (sans étui souple)

Accessoires en option
Adaptateur CA pour Reader : AC-S5220E

La conception et les caractéristiques techniques sont 
sujettes à modification sans préavis.
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Index
Symboles

 (page) .....................................9

A
Anneau de fixation de la  

dragonne ................................10

B
Batterie ......................................18
BBeB Book ................................25
Bouton numéroté ...........36, 51, 55

C
Carte mémoire ...........................19
Carte mémoire SD ...............19, 85
Charge .......................................17 

Voir également le « Guide de 
démarrage »

Classement des livres par  
auteur .....................................43

Classement des livres par  
date ........................................43

Classement des livres par  
titre .............................13, 35, 43

Collection ...................................46
Commutateur POWER ..........9, 15
CONNECT eBooks ................7, 23

D
Dépannage ................................68
Diaporama ...........................57, 60

E
eBook Library ..........23, 25, 27, 30

Aide ........................................3
Installation ....Voir le « Guide de 

démarrage »
Désinstallation ......................77

eBooks .............................7, 23, 37

F
Fente pour carte mémoire .....9, 19

Fente pour « Memory Stick 
Duo » ..................................9

Fente pour carte mémoire  
SD .......................................9

Fichier audio ..............................51
Fichier RTF ..........................25, 38

H
Horizontal ............................41, 58
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I
Image .........................................55
Importation ................................23

Contenu ...............................25
Livres électroniques .............23

Informations ...............................42

L
Lecture de livres ........................35

et d’un fichier audio 
simultanée.........................53

Lien ............................................39
Liste de livres .......................13, 35

M
Manuel .........................................2
Menu d’accueil ...........................13
Menu d’index .......................43, 45
Menu d’options ....................13, 37
« Memory Stick Duo » .........19, 85
Mise à jour .................................78

O
Orifices de fixation de l’étui  

souple ....................................10

P
Paramètres par défaut ...............76
Prise DC IN ...............................10
Prise écouteurs .........................11

R
Réglages ...................................58

Date et heure .......................59
Diaporama ...........................60
Informations relatives à la 

version ..............................67
Mode de veille ................16, 61
Orientation ...........................58
Réglages avancés ...............63

Réglages avancés .....................63
Arrêt de l’appareil .................66
Formatage de la mémoire 

interne ...............................65
Verrouillage du Reader ........63

Réinitialisation ...........................68
Touche Reset .................11, 68

S
Signet ........................................47
Synchronization .........................34
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T
Table des matières ....................37
Témoin .........................................9
Touche Entrée .............................8
Touche MENU .......................9, 13
Touche NEXT ............................38
Touche numérique .....9, 36, 51, 55
Touche VOLUME .......................11
Touche  (taille) ........................10
Touches < ....................................9
Touches > ....................................9
Touches /// ........................8
Touche  (MARQUE) .........10, 47
Transfert .....................................27
Tri ...............................................43
Types de livres ...........................37

U
USB ...........................................28

Connecteur USB ............10, 28

V
Vertical .................................41, 58
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